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DS-530 II/DS-575W II/DS-770 II User's Guide
Welcome to the DS-530 II/DS-575W II/DS-770 II User's Guide. 
For a printable PDF copy of this guide, click here.

Note: Availability of products in this guide varies by country.
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Scanner Basics
See these sections to learn about the basic features of your scanner.
Scanner Parts Locations
User Replaceable Epson Scanner Parts
Changing the Power Off and Sleep Timer Settings
Using the Epson Smart Panel Mobile App

Scanner Parts Locations
See these sections to identify the parts on your scanner.
Scanner Parts
Scanner Buttons and Lights
Parent topic: Scanner Basics
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Scanner Parts

Note: The illustrations show the DS-575W II, but the parts are the same for the DS-530 II and DS-770 II.

1 ADF (Automatic Document Feeder)
2 Edge guides
3 Input tray
4 Input tray extension
5 Output tray
6 Output tray extensions
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7 Stopper

1 Kensington security slot
2 USB 3.0 port
3 Power inlet
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1 Cover open lever
2 Scanner cover
3 Pickup rollers
4 Separation rollers

1 AC adapter
2 Power cord
3 USB 3.0 cable

Parent topic: Scanner Parts Locations
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Scanner Buttons and Lights
Buttons
DS-530 II/DS-770 II

1 power button
2 double feed detection skip button
3 slow mode button
4 stop button
5 start button
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DS-575W II

1 power button
2 Wi-Fi connect button
3 Wi-Fi button
4 double feed detection skip button
5 slow mode button
6 stop button
7 start button



14

Lights
DS-530 II/DS-770 II

1 ! error light
2 automatic feeding mode light
3 ready light
4 double feed detection skip light
5 slow mode light
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DS-575W II

1 AP mode light
2 Wi-Fi light
3 ! error light
4 automatic feeding mode light
5 ready light
6 double feed detection skip light
7 slow mode light

Parent topic: Scanner Parts Locations

User Replaceable Epson Scanner Parts
U.S. and Canada: You can purchase optional accessories and replacement parts at epson.com (U.S.
sales) or epson.ca (Canadian sales). You can also purchase accessories from an Epson authorized
reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766) in the U.S. or 800-807-7766 in
Canada.
Latin America: You can purchase optional accessories and replacement parts from an Epson
authorized reseller. To find the nearest reseller, go to latin.epson.com. Or you can contact your nearest
sales office as described in "Where to Get Help".

https://www.epson.com
https://www.epson.ca
http://latin.epson.com
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Note: Availability of accessories varies by country.

Part Part number
Carrier sheet (5) B12B819051
Roller assembly kit B12B819671
Cleaning kit B12B819291
Flatbed scanner dock (DS-530 II/DS-770-
II only)

B12B819011

Epson Perfection V19 (for use with
scanner dock)

B11B231201

Epson Perfection V39 (for use with
scanner dock)

B11B232201

Parent topic: Scanner Basics
Related references
Where to Get Help (U.S. and Canada)
Where to Get Help (Latin America)

Changing the Power Off and Sleep Timer Settings
You can use the Epson Scan 2 Utility to change the time period before the scanner enters sleep mode
and turns off automatically.

Note: The Power Off and Sleep Timer settings may not be available when you connect to the scanner
over a network (ES-500W II) (DS-575W II).

1. Do one of the following to access the Epson Scan 2 Utility:

• Windows 10: Click and select EPSON > Epson Scan 2 Utility.
• Windows 8.x: Navigate to the Apps screen and select Epson Scan 2 Utility.

• Windows (other versions): Click or Start, and select All Programs or Programs. Select
EPSON > Epson Scan 2 > Epson Scan 2 Utility.

• Mac: Open the Applications folder, open the Epson Software folder, and select Epson Scan 2
Utility.
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2. Click the Power Save tab.

3. Select the length of time after which you want the scanner to go to sleep as the Sleep Timer setting.
4. Select the length of time after which you want the scanner to automatically turn off when not in use

as the Power Off Timer setting.
5. Select the length of time after which you want the scanner to automatically turn off when not in use

as the AC power or AC adapter setting. You can also turn off the timer.
6. Turn on the Direct Power On setting if you want the scanner to turn on when it is connected to the

power source, without pressing the power button.
7. Click Set to save the settings.
8. Close the Epson Scan 2 Utility.
Parent topic: Scanner Basics
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Using the Epson Smart Panel Mobile App
Use this free Apple and Android app to scan with networked Epson products (DS-575W II).
1. Connect your product to your wireless network. See the link below.
2. Visit epson.com/connect (U.S), epson.ca/connect (Canada), or latin.epson.com/connect

(Caribbean) to learn more about Epson Smart Panel and check the compatibility of your mobile
device.

3. Download Epson Smart Panel from the Apple App Store or Google Play.
4. Connect your mobile device to the same wireless network as your product.
5. Open Epson Smart Panel and select your Epson product, if necessary.
Now you are ready to scan with your mobile device and your Epson product.
Parent topic: Scanner Basics
Related tasks
Setting Up Network Scanning

https://www.epson.com/connect
https://www.epson.ca/connect
https://latin.epson.com/connect
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Loading Originals
Follow the instructions here to load your originals into the scanner.

Note: The illustrations show the DS-575W II, but the steps are the same for the DS-530 II and DS-770 II.

Loading Originals in the Input Tray
Loading Plastic and Laminated Cards in the Input Tray
Loading Special Originals

Loading Originals in the Input Tray
You can load originals that meet the document specifications in the input tray.

Caution: Do not load photos, valuable original documents or artwork, directly into the input tray. This
may wrinkle or damage the original. Load these originals using an optional carrier sheet.

Note: Photos scanned using a document scanner may not have the same color depth as the original.
Use a flatbed photo scanner with the optional flatbed scanner dock (DS-530 II/DS-770 II) to achieve the
best color reproduction of photos.

The steps below describe loading originals of the same size. To load originals of multiple sizes at once,
see the link at the end of these steps.
1. Open the input tray and pull up its extension.
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2. Pull out the output tray and its extension, and open the stopper.

Note: If you are loading an original that is 15.5 inches (393.8 mm) or longer, do not pull out the input
or output tray extensions and do not open the stopper.

3. Slide the input tray edge guides all the way out.
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4. If you are loading a multi-page original, fan your stack of originals.

Note: If you are loading an original that is 15.5 inches (393.8 mm) or longer, load only one sheet at a
time.

5. Stack the originals with the printed side facing down and slide the stack so the leading edge is at an
angle as shown.
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6. Load standard originals into the input tray printed side down and top edge first, and guide them in
until they meet resistance.

• If you are loading paper business cards, load up to 15 (DS-530 II/DS-575W II) or 30 (DS-770 II)
cards printed side down and long edge first into the input tray horizontally, and slide them in until
they meet resistance.
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• If you are loading hole-punched originals, load them with the holes facing down or to the side as
shown. The holes must be within 1.2 inches (30 mm) of the edge of the originals.

7. Slide the edge guides against the edges of the original.



25

Note: If you are scanning originals that are 15.5 inches (393.8 mm) or longer, support the original as
it enters into and ejects from the scanner as shown.

8. If necessary during scanning, adjust the position of the stopper on the output tray extension to fit the
ejected originals.

Note: If thicker paper does not eject properly or falls from the output tray, push in the output tray and
allow the originals to eject freely onto the surface below the scanner. If the scanned images are
affected by the originals ejecting below the scanner, try placing the scanner on the edge of a table
where the ejected originals can drop freely.
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9. If scanning thin or wrinkled paper causes paper jams, press the slow mode button once before
scanning to slow down the feeding speed; press it again to return to normal speed.

If a paper feed error is detected, the Paper Protection feature stops the scanning process automatically
to reduce damage to the original. To change the Paper Protection detection level, open the Epson Scan
2 Utility, click on the Scanner Setting tab, and select the desired level from the Paper Protection drop-
down list.

Note: The Paper Protection feature does not prevent all documents from being damaged. Paper feed
errors may not be detected depending on the paper feeding conditions.

Loading Multiple Sizes of Originals in the Input Tray
Original Document Specifications
Parent topic: Loading Originals
Related references
Original Document Specifications
Related topics
Scanning

Loading Multiple Sizes of Originals in the Input Tray
You can load originals of different sizes, paper types, and thicknesses at one time in the input tray. Just
make sure they meet the original document specifications.
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Caution: Do not load photos, or valuable original documents or artwork, directly into the input tray. This
may wrinkle or damage the original. Load these originals using an optional carrier sheet.

Note: Photos scanned using a document scanner may not have the same color depth as the original.
Use a flatbed photo scanner with the optional flatbed scanner dock (DS-530 II/DS-770 II) to achieve the
best color reproduction of photos.

1. Open the input tray and pull up its extension.
2. Pull out the output tray and its extension, and open the stopper.

Note: If you are loading originals that are 15.5 inches (393.8 mm) or longer, do not pull out the input
or output tray extensions and do not open the stopper.
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3. Slide the input tray edge guides all the way out.

4. Load the originals in the input tray in descending order of paper size with the widest at the back and
the narrowest at the front. Slide them in until they meet resistance. Make sure the printed sides are
facedown and the top edges are slightly angled in the input tray.
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5. Slide the edge guides against the edges of the widest original.
6. If necessary during scanning, adjust the position of the stopper on the output tray extension to fit the

ejected originals.

Note: If thicker paper does not eject properly or falls from the output tray, push in the output tray and
allow the originals to eject freely onto the surface below the scanner. If the scanned images are
affected by the originals ejecting below the scanner, try placing the scanner on the edge of a table
where the ejected originals can drop freely.

If scanning thin or wrinkled paper causes paper jams, press the slow mode button once before
scanning to slow down the feeding speed; press it again to return to normal speed.

Parent topic: Loading Originals in the Input Tray
Related topics
Scanning

Original Document Specifications
You can load original documents that meet these specifications in your scanner.
DS-530 II/DS-575W II
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Paper type Paper size Paper weight Loading capacity
Plain paper
Fine paper
Recycled paper

Letter (8.5 × 11 inches
[216 × 279 mm])

7 to 110 lb
(27 to 413 g/m²)

21 lb (80 g/m²): 50 sheets
24 lb (90 g/m²): 43 sheets
28 lb (104 g/m²): 37
sheets
34 lb (127 g/m²): 31
sheets
42 lb (157 g/m²): 25
sheets
56 lb (209 g/m²): 19
sheets
68 lb (256 g/m²): 15
sheets
110 lb (413 g/m²): 9
sheets
Loading capacity may
vary depending on the
paper type.

Legal (8.5 × 14 inches
[216 × 356 mm])
A4 (8.3 × 11.7 inches
[210 × 297 mm])
A5 (5.8 × 8.2 inches
[148 × 210 mm])
A6 (4.1 × 5.8 inches
[105 × 148 mm])
B5 (7.2 × 10.1 inches
[182 × 257 mm])
B6 (5 × 7.2 inches
[128 × 182 mm])
A8 (2.1 × 2.9 inches
[52 × 74 mm])

34 to 110 lb
(127 to 413 g/m²)

Paper business cards Business cards Up to 56 lb
(210 g/m²)

15 cards loaded
horizontally

DS-770 II
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Paper type Paper size Paper weight Loading capacity
Plain paper
Fine paper
Recycled paper

Letter (8.5 × 11 inches
[216 × 279 mm])

7 to 110 lb
(27 to 413 g/m²)

21 lb (80 g/m²): 100
sheets
24 lb (90 g/m²): 86 sheets
28 lb (104 g/m²): 74
sheets
34 lb (127 g/m²): 62
sheets
42 lb (157 g/m²): 50
sheets
56 lb (209 g/m²): 38
sheets
68 lb (256 g/m²): 30
sheets
110 lb (413 g/m²): 18
sheets
Loading capacity may
vary depending on the
paper type.

A4 (8.3 × 11.7 inches
[210 × 297 mm])
A5 (5.8 × 8.2 inches
[148 × 210 mm])
A6 (4.1 × 5.8 inches
[105 × 148 mm])
B5 (7.2 × 10.1 inches
[182 × 257 mm])
B6 (5 × 7.2 inches
[128 × 182 mm])
A8 (2.1 × 2.9 inches
[52 × 74 mm])

34 to 110 lb
(127 to 413 g/m²)
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Paper type Paper size Paper weight Loading capacity
Plain paper
Fine paper
Recycled paper

Legal (8.5 × 14 inches
[216 × 356 mm])

7 to 110 lb
(27 to 413 g/m²)

21 lb (80 g/m²): 80 sheets
24 lb (90 g/m²): 69 sheets
28 lb (104 g/m²): 59
sheets
34 lb (127 g/m²): 50
sheets
42 lb (157 g/m²): 40
sheets
56 lb (209 g/m²): 30
sheets
68 lb (256 g/m²): 24
sheets
110 lb (413 g/m²): 14
sheets

Paper business cards Business cards Up to 56 lb
(210 g/m²)

30 cards loaded
horizontally

Note: You can load originals of different sizes, paper types, and thicknesses up to this size: Letter
(8.5 × 11 inches [216 × 279 mm]).

The following types of originals may not be successfully scanned or may require special attention:
• Originals with uneven surfaces, such as embossed documents or letterhead
• Originals with wrinkles or fold lines
• Perforated originals
• Originals with labels or stickers
• Carbonless paper
• Curled originals
• Coated paper

Note: Lightly wrinkled paper may scan better if you slow down the feeding speed during scanning or
smooth out the wrinkles before loading. Use a carrier sheet to scan delicate originals or originals that are
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easily wrinkled. To scan originals that are incorrectly detected as double feeds, press the double feed
detection skip button before scanning, or set the Detect Double Feed setting to Off on the Main Settings
tab in the Epson Scan 2 window.

Caution: Do not load the following types of originals directly in the scanner, or they may be damaged or
may damage the scanner:
• Photos
• Originals that are bound
• Passports
• Thermal paper
• Fabric or other non-paper originals
• Originals containing staples or paper clips
• Originals with wet ink or glue
• Ripped originals
• Heavily wrinkled or curled originals
• Originals with holes on the bottom of them
• Transparencies
• Originals with carbon paper backing
• Originals with sticky notes attached
• Glossy originals

Note: Photos scanned using a document scanner may not have the same color depth as the original.
Use a flatbed photo scanner with the optional flatbed scanner dock (DS-530 II/DS-770 II) to achieve the
best color reproduction of photos.

Parent topic: Loading Originals in the Input Tray

Loading Plastic and Laminated Cards in the Input Tray
You can load plastic and laminated cards that meet the card specifications in the input tray.
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1. Open the input tray, pull out the output tray, and open the stopper. Do not pull out the extensions.

2. Slide the input tray edge guides all the way out.
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3. Load plastic or laminated cards printed side down and long edge first into the input tray horizontally,
and slide them in until they meet resistance.
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Note: Do not load plastic cards vertically.
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4. Slide the edge guides against the edges of the card.

5. Turn off the Detect Double Feed setting on the Main Settings tab in Epson Scan 2 when scanning
the cards.

Note: If you do not disable the Detect Double Feed setting and a double feed error occurs, remove
the plastic or laminated card from the input tray and reload it. Press the double feed detection skip
button to disable the Detect Double Feed feature and scan again.
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Plastic and Laminated Card Specifications
Parent topic: Loading Originals
Related references
Plastic and Laminated Card Specifications
Related topics
Scanning

Plastic and Laminated Card Specifications
You can load original plastic and laminated cards that meet these specifications in your scanner.

Paper type Paper size Paper thickness Loading capacity
Plastic cards,
embossed (ISO781A
ID-1 compliant)

2.1 × 3.3 inches
(54 × 85.6 mm)

0.05 inch (1.24 mm)
maximum

1 card (horizontal)

Plastic cards, standard
(ISO781A ID-1
compliant)

0.03 inch (0.76 mm)
maximum

5 cards (horizontal)

Laminated cards 4.7 × 5.9 inches (120 ×
150 mm) or smaller

0.03 inch (0.8 mm)
maximum

1 card

Note: Plastic cards with glossy surfaces may not scan properly.

Parent topic: Loading Plastic and Laminated Cards in the Input Tray

Loading Special Originals
You can load a photo or large, thick, or folded original in the input tray using one or more carrier sheets.
You can also load envelopes. Make sure the originals meet the specifications for special originals before
loading them.
1. Open the input tray and pull up its extension.
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2. Pull out the output tray and its extension, and open the stopper.

Note: If you are loading originals that are 15.5 inches (393.8 mm) or longer, do not pull out the input
or output tray extensions and do not open the stopper.

3. Slide the input tray edge guides all the way out.
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4. Load envelopes vertically in the input tray with the printable side down and the flap facing as shown.
Slide in the envelopes until they meet resistance.
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5. Do one of the following to load a photo, or folded or irregularly shaped originals:
• For a Letter- or A4-size or larger original, fold it as shown and place it in the center of an optional

carrier sheet. Make sure the illustration on the front edge of the carrier sheet is facing up.

• For a photo or an irregularly shaped original, load it in the center of an optional carrier sheet with
the printed side face down. Make sure the illustration on the front edge of the carrier sheet is
facing up.

Note: Photos scanned using a document scanner may not have the same color depth as the
original. Use a flatbed photo scanner with the optional flatbed scanner dock (DS-530 II/DS-770 II) to
achieve the best color reproduction of photos.
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6. Load the carrier sheet in the input tray as shown until it meets resistance.
Folded original
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Photo or irregularly shaped original

7. Slide the edge guides against the edges of the original or carrier sheet.

8. Turn off the Detect Double Feed setting on the Main Settings tab in Epson Scan 2 when scanning
special originals.
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9. If necessary during scanning, adjust the position of the stopper on the output tray extension to fit the
ejected originals.

Note: If thicker paper does not eject properly or falls from the output tray, push in the output tray and
allow the originals to eject freely onto the surface below the scanner. If the scanned images are
affected by the originals ejecting below the scanner, try placing the scanner on the edge of a table
where the ejected originals can drop freely.

Special Original Specifications
Parent topic: Loading Originals
Related references
Special Original Specifications
Related topics
Scanning

Special Original Specifications
You can load photos, envelopes, or large, thick, or folded originals that meet these specifications in your
scanner.

Note: Photos scanned using a document scanner may not have the same color depth as the original.
Use a flatbed photo scanner with the optional flatbed scanner dock (DS-530 II/DS-770 II) to achieve the
best color reproduction of photos.

Paper type Paper size Paper thickness Loading capacity
Large originals (plain
paper, fine paper, or
recycled paper)
(load only in a carrier
sheet)

Up to this size: A3 (11.7 × 16.5
inches [297 × 420 mm])

0.012 inch (0.3 mm)
maximum
(excluding the
thickness of the carrier
sheet)

DS-530 II/DS-575W II:
5 carrier sheets
DS-770 II: 10 carrier
sheets

Photos
(load only in a carrier
sheet)

Up to this size: A4 (8.3 × 11.7
inches [210 × 297 mm])

0.012 inch (0.3 mm)
maximum
(excluding the
thickness of the carrier
sheet)

DS-530 II/DS-575W II:
5 carrier sheets
DS-770 II: 10 carrier
sheets
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Paper type Paper size Paper thickness Loading capacity
Envelopes 4.49 × 6.38 inches (114 ×

162 mm)
4.33 × 8.66 inches (110 ×
220 mm)

0.015 inch (0.38 mm)
maximum

DS-530 II/DS-575W II:
5 envelopes
DS-770 II: 10
envelopes

Irregularly shaped
originals
(load only in a carrier
sheet)

Up to this size: A4 (8.3 × 11.7
inches [210 × 297 mm])

0.012 inch (0.3 mm)
maximum
(excluding the
thickness of the carrier
sheet)

DS-530 II/DS-575W II:
5 carrier sheets
DS-770 II: 10 carrier
sheets

Note: Originals that are wider than 8.5 inches (215.9 mm) need to be folded in half. The leading edge of
originals approximately 11.7 inches (297 mm) long must be placed at the binding part of the carrier
sheet. Otherwise, the length of the scanned image may be longer than intended as the scanner scans to
the end of the carrier sheet when you select Auto Detect as the Document Size setting in the scanning
software.

Parent topic: Loading Special Originals
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Wi-Fi Networking
See these sections to use your scanner over a Wi-Fi network (DS-575W II).
Network Security Recommendations
Connecting to an Existing Wi-Fi Network
Setting Up Wireless Scanning from a Smart Device Using Epson Smart Panel
Direct Wi-Fi Mode (AP Mode) Setup
Wi-Fi Protected Setup (WPS)
Setting Up Network Scanning
Disabling Wi-Fi Features
Restoring Default Network Settings

Network Security Recommendations
To help deter unauthorized access to your product over a network, you should protect your network
environment using appropriate security measures.
Security measures such as these can help deter threats such as loss of user data, use of telephone and
fax lines, and other intrusions:
• Enable security on your wireless LAN

Enable the appropriate security on the wireless LAN you plan to use with your product. Network
security such as a network password can deter interception of traffic over the wireless LAN. Your
router may already have a default password enabled by your Internet service provider (ISP). See your
ISP and router documentation for instructions on how to change the default password and better
secure your network.

• Connect your product only to a network protected by a firewall
Connecting your product directly to the Internet may leave it vulnerable to security threats. Instead,
connect it to a router or other network connection protected by a firewall. Your router may already
have a firewall set up by your Internet service provider; check with your ISP for confirmation. For best
results, set up and use a private IP address for your network connection.

• Change the default administrator password on your product
If your product has an option to set an administrator password, change the default administrator
password to deter access by unauthorized users to personal data stored on your product, such as IDs,
passwords, and contact lists.

Parent topic: Wi-Fi Networking
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Connecting to an Existing Wi-Fi Network
You can set up your scanner to communicate with your computer using a wireless router. The wireless
router can be connected to your computer over a wireless or wired network.

1 Epson scanner
2 Wireless router
3 Computer with a wireless interface
4 Computer
5 Internet
6 Ethernet cable (used only for wired connection to the wireless router)

Manually Connecting to a Wi-Fi Network
Parent topic: Wi-Fi Networking
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Manually Connecting to a Wi-Fi Network
You can manually connect the scanner to a Wi-Fi network by entering the network names (SSIDs) and
passwords for your wireless network router and scanner. You must have a computer with a wireless
adapter to set up the connection. Also make sure you have installed the scanner software as described
on the scanner Start Here sheet.

Note: For best results, re-install your scanner software and follow the on-screen instructions to connect
to a network.

1. Make a note of the SSID and password shown on the label on the back of the scanner.
2. Turn on the scanner.
3. Press the Wi-Fi button on the scanner's control panel.
4. From your computer or device, open the list of wireless networks and select the SSID shown on the

scanner label. Then select the connect option.
5. Enter the password shown on the scanner label.

The AP mode light comes on in blue, indicating an AP mode connection.
6. Connect your computer or device to the wireless network.

Wait for the Wi-Fi light on the scanner to stop flashing and stay on, indicating that the scanner is
connected to the network.

7. Select the link below to set up network scanning. You must set up network scanning to connect your
computer and wireless scanner.

Parent topic: Connecting to an Existing Wi-Fi Network
Related tasks
Setting Up Network Scanning

Setting Up Wireless Scanning from a Smart Device Using Epson Smart
Panel

You can use the Epson Smart Panel app to connect your Epson product to a wireless network or
connect your smart device directly to the product. Epson Smart Panel is available on iOS and Android
devices.
Make sure you have the following:
• A Bluetooth-enabled device that is connected to a wireless network
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• The Epson Smart Panel app installed on the device
• The wireless network name (SSID) and password

Note: Your device must be close enough to the product to create and maintain a Bluetooth connection.

1. Make sure the product is turned on and is ready to scan.

Note: You must perform initial setup before setting up wireless scanning.

2. Open the Epson Smart Panel app on your device.
3. Do one of the following:

• If the app automatically recognizes the product, follow the on-screen instructions to set up the
wireless connection.

• If the app does not automatically recognize the product, select the + icon and continue with the
next step.

4. On the next screen, select Connect to a New Product.
5. Select your product from the list.

Note: If your product is not listed, move closer to the product and try again. If the product is still not
shown, connect your scanner to the wireless network again and then select Connect to Existing
Product in the Epson Smart Panel app and follow the on-screen instructions. See the link below for
wireless setup instructions.

6. Select Next to select the current wireless network.

Note: If you want to connect the product to a different wireless network, select Change another Wi-
Fi SSID.

7. Enter the password for the wireless network and select OK.
The app starts configuring the product.

Note: Do not move the smart device away from the product during configuration. Wait for the
completion message in the Epson Smart Panel app and do not cancel the configuration before it is
completed.
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Your product is now connected to a wireless network and set up for use with the Epson Smart Panel
app.
Parent topic: Wi-Fi Networking
Related tasks
Using the Epson Smart Panel Mobile App
Starting a Scan from a Smart Device

Direct Wi-Fi Mode (AP Mode) Setup
You can set up your scanner to communicate directly with your computer or another device without
requiring a wireless router. If your product is not already connected to a wireless network, it enters
access point mode and the scanner itself acts as the network access point for up to 4 devices.

1 Epson scanner
2 Computer with a wireless interface
3 Other wireless devices
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Note: Devices directly connected to the scanner cannot communicate with each other through the
scanner.

Enabling a Direct Wi-Fi (AP Mode) Connection
Using WPS to Set Up a Direct Wi-Fi Connection
Parent topic: Wi-Fi Networking

Enabling a Direct Wi-Fi (AP Mode) Connection
You can enable a direct Wi-Fi connection to allow direct communication between your scanner and
computer or other devices without a wireless router or access point.

Note: If you are connecting a wireless device to the scanner using a direct Wi-Fi (AP mode) connection,
the scanner is connected to the same Wi-Fi network (SSID) as the wireless device. When you turn off
the scanner, the wireless device is automatically connected to other Wi-Fi networks, so you must
reconnect to the scanner in AP mode from the wireless device when you turn the scanner back on. To
avoid reconnecting every time you turn the scanner off and back on, connect the scanner to an access
point instead.

1. Make a note of the SSID and password shown on the label on the back of the scanner.
2. Open the scanner's input tray.
3. Press the Wi-Fi button on the scanner's control panel.
4. From your computer or device, search for and select the SSID shown on the label on the back of the

scanner.
5. Enter the password shown on the label on the back of the scanner.

The AP mode light lights up in blue indicating an AP mode connection. If the connection is
unsuccessful, make sure you entered the password correctly.

Parent topic: Direct Wi-Fi Mode (AP Mode) Setup

Using WPS to Set Up a Direct Wi-Fi Connection
You can use Wi-Fi Protected Setup (WPS) to create a direct Wi-Fi connection to a WPS-enabled
computer or device.
1. Press the WPS button on your computer or device, or enable the WPS feature.

The computer or device enters standby mode for WPS connection for 2 minutes.



52

2. Press and hold the Wi-Fi connect button on the scanner for at least 3 seconds, then release it
when the Wi-Fi light flashes blue.
When the Wi-Fi light on the scanner stays on, the connection is established.

Parent topic: Direct Wi-Fi Mode (AP Mode) Setup

Wi-Fi Protected Setup (WPS)
If your network uses a WPS-enabled wireless router, you can quickly connect your scanner to the
network using Wi-Fi Protected Setup (WPS).

Note: To check if your router is WPS-enabled, look for a button labeled WPS on your router. If there is
no hardware button, there may be a WPS setting in the software for the device. Check your network
product documentation for details.

Using WPS to Connect to a Network
Using WPS PIN Mode to Connect to a Network
Parent topic: Wi-Fi Networking

Using WPS to Connect to a Network
If you have a WPS-enabled wireless router, you can use Wi-Fi Protected Setup (WPS) to connect your
scanner to the network. Make sure you have installed your scanner software as described on your
scanner Start Here sheet.

Note: For best results, re-install your scanner software and follow the on-screen instructions to connect
to a network.

1. Open the scanner's input tray.
2. Enable WPS on your router by pressing and holding the WPS button on your wireless router until the

security light flashes or by enabling the WPS setting in your router firmware.
The router enters WPS discovery mode for 2 minutes.

Note: If you cannot locate the WPS button, or there are no buttons on the router or access point, see
the documentation provided with your router for details.
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3. Press and hold the Wi-Fi connect button on the scanner for at least 3 seconds, then release it
when the Wi-Fi light flashes blue.

Note: If you do not complete this step within 2 minutes, repeat steps 1 through 3.

The Wi-Fi and AP mode lights flash alternately while establishing the connection. When the
Wi-Fi light on the scanner stays on, the scanner is connected to the network.

Note: If the ! error light turns on, the connection failed. Press the stop button to clear the error,
restart the scanner and router, and repeat these steps.

4. Select the link below to set up network scanner. You must set up network scanning to connect your
computer and wireless scanner.

Parent topic: Wi-Fi Protected Setup (WPS)
Related tasks
Setting Up Network Scanning

Using WPS PIN Mode to Connect to a Network
If you have a WPS-enabled wireless router that supports PIN mode, you can use Wi-Fi Protected Setup
(WPS) PIN mode to connect your scanner to the network.
1. Open the scanner's input tray.
2. Press and hold the Wi-Fi button and the Wi-Fi connect button on the scanner simultaneously

for at least three seconds, then release them when the Wi-Fi light flashes blue.

Note: The scanner enters discovery mode for 2 minutes.

3. Use your computer to enter the PIN code 01234565 into the WPS PIN number setting in the wireless
router within 2 minutes.

Note: If you do not enter the code within 2 minutes, repeat steps 1 through 3.

The Wi-Fi and AP mode lights flash alternately while establishing the connection. When the
Wi-Fi light on the scanner stays on, the scanner is connected to the network.

Note: If the ! error light turns on, the connection failed. Press the stop button to clear the error,
restart the router, and repeat these steps.
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4. Select the link below to set up network scanning. You must set up network scanning to connect your
computer and wireless scanner.

Parent topic: Wi-Fi Protected Setup (WPS)
Related tasks
Setting Up Network Scanning

Setting Up Network Scanning
You can set up network scanning to your scanner through a direct connection to your scanner.
First, manually configure your scanner to connect to your network. Then follow the instructions here to
set up your computer for network scanning using the Epson Scan 2 Utility. Your scanner must be turned
on and connected to the network.

Note: Make a note of the IP address or host name of the scanner so you can enter it in these steps.

1. Do one of the following to start the Epson Scan 2 Utility:

• Windows 10: Click > EPSON > Epson Scan 2 Utility.
• Windows 8.x: Navigate to the Apps screen and select Epson Scan 2 Utility.

• Windows (other versions): Click or Start > All Programs or Programs > EPSON > Epson
Scan 2 > Epson Scan 2 Utility.

• Mac: Open the Applications folder, click Epson Software, and click Epson Scan 2 Utility.
2. Select Settings from the Scanner drop-down list.
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You see a screen like this:

Note: If you see an Enable Editing button (Windows) or the lock icon (Mac), click it so that you can
modify the scanner settings.

3. Select your scanner and click Add.
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You see a screen like this:

4. Do one of the following:
• Under Search for Network, select the IP address of your Epson scanner and click Add.
• Select the Enter address setting, type in the IP address or host name of your Epson scanner, and

click Add.
5. Click OK to check the connection.

You see a confirmation message.
6. Click OK to save your settings and close the Epson Scan 2 Utility.
Determining the Scanner's IP Address
Parent topic: Wi-Fi Networking
Related tasks
Determining the Scanner's IP Address
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Determining the Scanner's IP Address
If you have multiple scanners on your network, you need to know the IP address of the scanner when
setting up network scanning.
1. Do one of the following to start EpsonNet Config:

• Windows 10: Click > EpsonNet > EpsonNet Config.
• Windows 8.x: Navigate to the Apps screen and select EpsonNet Config.

• Windows (other versions): Click or Start, and select All Programs or Programs. Select
EpsonNet > EpsonNet Config > EpsonNet Config.

• Mac: Open the Applications folder and select Epson Software > EpsonNet > EpsonNet Config
> EpsonNet Config.

2. Locate your scanner in the list and write down the IP address.
Parent topic: Setting Up Network Scanning

Disabling Wi-Fi Features
You may need to disable your product's Wi-Fi features if you change your network connection type or
need to solve a problem with your network connection.

Note: Before disabling Wi-Fi features, make a note of your product's SSID (network name) and
password, and any network settings selected for Epson DocumentScan.

Press and hold the Wi-Fi button on the scanner for at least three seconds to disable the Wi-Fi
features. When the Wi-Fi light and the AP mode light turn off, Wi-Fi is disabled.
Parent topic: Wi-Fi Networking

Restoring Default Network Settings
If you need to solve a problem with your network connection, you can restore all network settings to their
defaults.
1. Turn off your scanner.
2. Press and hold the Wi-Fi button and the power button until the Wi-Fi and AP mode

lights turn on. Then release the buttons.
3. Wait until the Wi-Fi and AP mode lights flash alternately and then turn off.

The default network settings are restored.
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Parent topic: Wi-Fi Networking
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Scanning
You can scan your originals and save them as digital files.

Note: Your product may differ from the images in this guide, but the instructions are the same unless
otherwise noted.

Starting a Scan
Scanning with Simple Scan in Document Capture Pro - Windows
Scanning with Job Scan in Document Capture Pro - Windows
Scanning with Document Capture - Mac
Scanning in Epson Scan 2
Scan Resolution Guidelines
Scanning Special Projects

Starting a Scan
After placing your originals on your product for scanning, start scanning using one of these methods.

Note: You can also scan using Document Capture Pro (Windows) or Document Capture (Mac).

Starting a Scan from a Scanner Button
Starting a Scan Using the Epson Scan 2 Icon
Starting a Scan from a Scanning Program
Starting a Scan from a Smart Device
Parent topic: Scanning

Starting a Scan from a Scanner Button
You can scan using the start button on your scanner. This automatically starts Document Capture Pro
(Windows) or Document Capture (Mac) and the scan job you have assigned to the button.

Note: Make sure Epson Scan 2 and either Document Capture Pro (Windows) or Document Capture
(Mac) are installed on the computer connected to the scanner. Document Capture Pro (Windows) and
Document Capture (Mac) do not support scanning from the start button on your scanner over a
wireless network (DS-575W II). Launch Epson Scan 2 before scanning from the start button on your
scanner.
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1. Make sure the scanner is connected to your computer or network.
2. Load an original in your scanner.
3. Press the start button.

The scanner starts the job that was assigned to the start button in Document Capture Pro
(Windows) or Document Capture (Mac).

Note: You can view or change the scan settings using Document Capture Pro (Windows) or
Document Capture (Mac).

Note: If your scanner is connected to one computer via USB and another computer via wireless,
pressing the start button on the scanner will save the scanned images to the wirelessly connected
computer (DS-575W II).

Adding and Assigning Scan Jobs with Document Capture Pro - Windows
Assigning Start Button Settings or Scan Jobs - Mac
Parent topic: Starting a Scan
Related topics
Loading Originals

Adding and Assigning Scan Jobs with Document Capture Pro - Windows
You can view, change, or add available default scan settings when you scan using the start button on
your product or the Job Scan option in Document Capture Pro. You do this by accessing the scan jobs in
the Document Capture Pro program.

Note: The settings may vary, depending on the software version you are using. See the help information
in Document Capture Pro for details.

1. Do one of the following to start Document Capture Pro:

• Windows 10: Click and select Epson Software > Document Capture Pro.
• Windows 8.x: Navigate to the Apps screen and select Document Capture Pro.

• Windows (other versions): Click or Start, and select All Programs or Programs. Select
Epson Software > Document Capture Pro.

You see the Document Capture Pro window.
2. Select the Job Scan tab.
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You see a window like this:

3. Click the Job Settings button.
You see a window like this:

4. To add a scan job, click the New Job icon.
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5. Enter a name for the new job, and select any settings as necessary from the following options:
• Scan: select the size, color, or resolution
• Save: select the file name, file type, or destination folder
• Index: enable the index setting and choose output options for an index file
• Send: select the destination for the scanned file, or choose to email or print the file
• Confirm/Test: select the job button icon and color, choose display settings, and run a test scan if

necessary
6. Click Save when you are finished.

The new job appears in the Job Scan window.
7. To assign a scan job to the start button on your product, click the Button Assignment icon.

You see a screen like this:
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8. Select the job that you want to assign to the start button using any of the pull-down menus.

Note: The number of pull-down menus available may vary, depending on your product and any
connected options.

9. Click OK, then click Back.
You can now use the added scan jobs when you scan from the start button on your product.

Parent topic: Starting a Scan from a Scanner Button
Assigning Start Button Settings or Scan Jobs - Mac

You can view or change the default scan settings when you scan using the start button on your
scanner. You do this by accessing the scan jobs in the Document Capture program.

Note: Document Capture (Mac) does not support scanning from the start button on your scanner over
a wireless network (DS-575W II). Launch Epson Scan 2 before scanning from the start button on your
scanner.

1. Start Document Capture on a computer connected to the product.

2. Click the Manage Job icon from the toolbar at the top of the window.
You see a window showing the current scan job list.

3. If you want to add a scan job, click Add or the + icon, enter a name for the new job, select settings
as necessary, and click OK.
You can now use the new scan job when you scan with Document Capture.

Note: See the Help information in Document Capture for details.

4. If you want to assign a scan job to the start button, click the icon at the bottom of the
window and click Event Settings.
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5. Select the job that you want to assign to the start button.

6. Click OK.
Parent topic: Starting a Scan from a Scanner Button

Starting a Scan Using the Epson Scan 2 Icon
You can start the Epson Scan 2 program to select scan settings, scan, and save the scanned image to a
file.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software
from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

• Windows 10: Click and select EPSON > Epson Scan 2.
• Windows 8.x: Navigate to the Apps screen and select Epson Scan 2.

• Windows (other versions): Click or Start, and select All Programs or Programs. Select EPSON
> Epson Scan 2 > Epson Scan 2.

• Mac: Open the Applications folder, open the Epson Software folder, and select Epson Scan 2.
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You see an Epson Scan 2 window like this:
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Parent topic: Starting a Scan

Starting a Scan from a Scanning Program
You can start Epson Scan 2 from a TWAIN-compliant scanning program to select scan settings, scan,
and open the scanned image in the program.

Note: If you are using your Epson product with the Windows 10 S operating system, you cannot use the
software described in this section. You also cannot download and install any Epson product software
from the Epson website for use with Windows 10 S; you must obtain software only from the Windows
Store.

1. Open your scanning program and select its scanning option. (See your scanning program help for
instructions.)

2. Select your product.

Note: In certain programs, you may need to select your product as the "source" first. If you see a
Select Source option, choose it and select your product. With Windows, do not select a WIA option
for your product; not all scan functions will be available.
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You see an Epson Scan 2 window like this:
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Parent topic: Starting a Scan

Starting a Scan from a Smart Device
You can use the Epson Smart Panel app to scan from a network scanner to an iOS or Android device
over a direct Wi-Fi connection (DS-575W II).
1. Download the Epson Smart Panel app from your device's app store or from Epson's website. See

the link below.
2. Place your original on the product for scanning.
3. Open the Epson Smart Panel app and select a scan menu on the home screen.
4. Follow the on-screen instructions to scan and save your original.
Parent topic: Starting a Scan
Related tasks
Using the Epson Smart Panel Mobile App

Scanning with Simple Scan in Document Capture Pro - Windows
You can use the Simple Scan option in Document Capture Pro to quickly scan an original.

Note: Settings may vary depending on the software version you are using. Click the Help icon in
Document Capture Pro at any time for more information.

1. Load your original in the product.
2. Do one of the following to start Document Capture Pro:

• Windows 10: Click and select Epson Software > Document Capture Pro.
• Windows 8.x: Navigate to the Apps screen and select Document Capture Pro.

• Windows (other versions): Click or Start, and select All Programs or Programs. Select
Epson Software > Document Capture Pro.

You see the Document Capture Pro window.

Note: You may need to select your scanner from the list, if necessary.

3. Select the Simple Scan tab.
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You see a window like this:

4. Select the size of your original from the Document Size menu.
5. If you want to change specific settings for the scan, click the Scan Settings button. Change any of

the settings as necessary and click OK. For additional settings, click the Detailed Settings button
on the Scan Settings screen.

6. Do one of the following:
• To scan the front side of an original, select SCAN single-sided.
• To scan both sides of an original, select SCAN double-sided.
Your product scans the original and the image appears in the Edit Scanned Results window.

7. Review and edit the scanned image as necessary and click Next when you are finished.
8. Select a destination for the scanned image, change any settings as necessary, and click Complete.

Note: If you are sending the scanned image to a server or cloud destination, you need to enter your
login information.

Parent topic: Scanning
Related tasks
Scanning in Epson Scan 2
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Related topics
Loading Originals

Scanning with Job Scan in Document Capture Pro - Windows
You can create scan jobs in Document Capture Pro and use them to quickly scan originals and save
them to various destinations.

Note: Settings may vary depending on the software version you are using. Click the Help icon in
Document Capture Pro at any time for more information.

1. Load your original in the product.
2. Do one of the following to start Document Capture Pro:

• Windows 10: Click and select Epson Software > Document Capture Pro.
• Windows 8.x: Navigate to the Apps screen and select Document Capture Pro.

• Windows (other versions): Click or Start, and select All Programs or Programs. Select
Epson Software > Document Capture Pro.

You see the Document Capture Pro window.

Note: You may need to select your scanner from the list, if necessary.

3. Select the Job Scan tab.
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You see a window like this:

4. Select one of the scan jobs (or click Job Settings to create a new scan job).
The product scans the loaded original and saves it according to the job settings.

5. Depending on the settings for the scan job you selected, you may be able to view and edit the pages
before saving them. If so, click Complete when finished.
The scanned image is saved according to the job settings.

Parent topic: Scanning
Related tasks
Scanning in Epson Scan 2
Related topics
Loading Originals

Scanning with Document Capture - Mac
When you scan with Document Capture, the program automatically saves your scanned file on your
computer in the folder you specify. You can select settings, preview, and change the scanned file
settings as necessary.

Note: Settings may vary depending on the software version you are using. See the Help menu in
Document Capture at any time for more information.
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1. Load your original in the product.
2. Open the Applications folder, open the Epson Software folder, and select Document Capture.

You see a window like this:

Note: You may need to select your scanner from the scanner list.

3. Click the scan icon.
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You see a window like this:

Note: If you want to use a scan job that you created instead, select it from the Job list in the
Document Capture window, click the Start Job button, and skip the rest of these steps.

4. Select any displayed scan settings you want to use.

Note: See the Help information in Document Capture for details.

5. If you want to select detailed scan settings, close the Scan Settings window, open the Scan menu at
the top of the Mac desktop, and select Displays the EPSON Scan Setup Screen.

6. Click the Scan icon and select any detailed scan settings you want to use from the Epson Scan 2
window.

7. Click Scan.
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You see a preview of your scan in the Document Capture window.

Note: You may have to close the Epson Scan 2 window to view your scan in the Document Capture
window.

8. If you would like to scan additional originals and add them to the current captured images, click the +
icon, select Acquire from Scanner, and repeat the previous steps.

9. Check the scanned images and edit them as necessary.
10. Click one of the destination icons to choose where to send your scanned files. (If you cannot see all

of the icons below, click the arrow next to the icons.) Change any settings as necessary.

Note: If you are sending the scanned image to a server or cloud destination, you need to enter your
login information.

11. Depending on the destination you chose, click OK or Send to complete the operation.
Parent topic: Scanning
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Related tasks
Scanning in Epson Scan 2
Related topics
Loading Originals

Scanning in Epson Scan 2
Epson Scan 2 gives you access to basic and advanced scanning features. You can scan your document
and save the scanned image in various file formats in your operating system's Documents or My
Documents folder, or open it in your scanning program. You can preview the scanned image and select
or change settings as necessary.
1. Load your original in the product.
2. Start Epson Scan 2.
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You see this window:
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Note: The Document Source setting is automatically set to ADF for your product.

3. If you want to scan different size originals by loading them into the ADF one by one, check the
Automatic Feeding Mode checkbox and click Scan. Scanning begins as soon as you load each
original.

4. Select the Scanning Side setting that matches the sides of the original that you want to scan.
5. Select the Document Size setting that matches the size of your original, or select Auto Detect to

have Epson Scan 2 automatically detect the size. You can select Customize to enter a custom size,
if necessary.

6. Click on one of the orientation icons, if applicable.
7. Select your original image type and how you want it scanned as the Image Type setting, or select

Auto to have Epson Scan 2 automatically detect the image type.
8. Select the Resolution setting you want to use for your scan.
9. Select any of the additional settings that you want to use on the Main Settings tab.
10. Click the Advanced Settings tab and select any settings that you want to use.
11. To see a preview of your scan with the settings you selected, click the Preview button.
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Epson Scan 2 previews your original and displays the results in the Epson Scan 2 window.

12. Reinsert your original into the ADF.
13. If scanning an original in a carrier sheet or other special original, see the link below for other setting

requirements for special documents.
14. Select the format in which you want to save your scanned file as the Image Format setting. If

necessary, select Options and select any desired format options.
15. Select Settings to modify the file name settings. Enter the file name for your scanned file in the File

Name field.
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16. Select the location in which you want to save your scanned file as the Folder setting. If necessary,
select Select to choose an alternate folder or create a new folder.

17. Click Scan.
The product scans your original and saves the scanned file in the location you specified.

18. If you selected the Automatic Feeding Mode setting, place your next original in the ADF for
scanning. When you finish scanning originals, click Finish.

Additional Scanning Settings - Main Settings Tab
Additional Scanning Settings - Advanced Settings Tab
Scanning Settings for Special Documents
Image Format Options
Parent topic: Scanning
Related topics
Loading Originals

Additional Scanning Settings - Main Settings Tab
You can select these additional scanning settings on the Epson Scan 2 Main Settings tab.
Stitch Images

When scanning double-sided originals, lets you lay out images from both sides of the original onto
one scanned page.

Rotate
Rotates the original image clockwise to the desired angle before scanning it. Select Auto to allow
your product to automatically rotate the image based on the orientation of the text (may take longer to
scan).

Correct Document Skew
Corrects skewed originals, image contents, or both.

Add or edit pages after scanning
Lets you add, remove, or edit the pages in a scan, including rotating pages and changing the page
order.

Note: To save multiple pages in a single file, you must select a file format that supports multiple
pages such as PDF or Multi-TIFF. If you select another file format, each scanned image or page is
saved as a separate file.
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Skip Blank Pages
If the scanner detects marks from the other side of a blank page and adds the marks to the scanned
image, adjust this setting to prevent this.

Detect Double Feed
Detects a double-feed paper error in the ADF. If you are scanning an original envelope or plastic card,
select Off.

Parent topic: Scanning in Epson Scan 2

Additional Scanning Settings - Advanced Settings Tab
You can select these additional scanning settings on the Epson Scan 2 Advanced Settings tab. Not all
adjustment settings may be available, depending on other settings you have chosen.
Unsharp Mask

Makes the edges of certain image areas clearer. Turn off this option to leave softer edges.
Descreening

Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This
option improves results when scanning magazines or newspapers. (The results of descreening do not
appear in the preview image, only in your scanned image.)

Remove Background
Removes the background of the originals.

Text Enhancement
Sharpens the appearance of letters in text documents.

Auto Area Segmentation
Makes black and white images clearer and text recognition more accurate by separating the text from
the graphics.

Dropout
The scan will not pick up the color you select. This setting is available only if you select Grayscale or
Black & White as the Image Type setting.

Color Enhance
Enhances the shades of the color you select in the scanned image. This setting is available only if you
select Grayscale or Black & White as the Image Type setting.

Brightness
Adjusts the overall lightness and darkness of the scanned image.

Contrast
Adjusts the difference between the light and dark areas of the overall scanned image.
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Gamma
Adjusts the midtone density of the scanned image.

Threshold
Adjusts the level at which black areas in text and line art are delineated, improving text recognition in
OCR (Optical Character Recognition) programs.

Edge Fill
Corrects shadowing around the edges of the image by filling the shadows with black or white.

Remove Punch Holes
Removes the shadows caused by holes on the edges of the original.

Dual Image Output
Scans the original image twice using different output settings (Windows only).

Watermark
Adds text to the background of the scanned image.

Parent topic: Scanning in Epson Scan 2

Scanning Settings for Special Documents
You need to select specific options on the Main Settings tab in Epson Scan 2 when scanning special
originals.

Type of original Required settings
Envelope Select Off as the Detect Double Feed setting.
Plastic cards Select Plastic Card (Landscape) as the Document Size

setting and Off as the Detect Double Feed setting.
Carrier sheet If you select Auto Detect as the Document Size setting,

paper skew is automatically corrected even if the Correct
Document Skew setting is set to Off.
If you select a setting other than Auto Detect as the
Document Size setting, you can only use Contents Skew
as the Correct Document Skew setting. As paper skew is
not applied in this case, only contents skew is corrected
when you select the Paper and Contents Skew setting.

Large originals If the Document Size list does not contain the document
size you want to scan, select Customize to create a custom
size.
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Type of original Required settings
Long paper If the Document Size list does not contain the document

size you want to scan, select Auto Detect (Long Paper) or
select Customize to create a custom document size.
If you are scanning folded originals without the carrier sheet,
select Off as the Detect Double Feed setting.

Laminated cards To scan any transparent areas around the edges of the
card, select Settings as the Document Size setting and
either select the Scan laminated card checkbox or create a
custom size.

Parent topic: Scanning in Epson Scan 2

Image Format Options
You can select different image formats and related options. For details on available options, click the ?
icon on the Epson Scan 2 Image Format Options window. Not all image formats have options.
BITMAP (*.bmp)

A standard image file format for most Windows programs.
JPEG (*.jpg)

An image format that lets you highly compress image data. However, the higher the compression, the
lower the image quality. (The TIFF format is recommended when you need to modify or retouch your
scanned image.)

PNG (*.png)
An image format that does not lose quality during editing.

TIFF (*.tif)
A file format created for exchanging data between many programs, such as graphic and DTP
software.

Multi-TIFF (*.tif)
A TIFF file format when multiple pages are saved to the same file, allowing you to edit the images
using a compatible program.

PDF (*.pdf)
A document format that is readable by Windows and Mac systems using Adobe Reader, Acrobat, or
other programs. You can save multi-page documents in one PDF file.
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Searchable PDF (*.pdf)
A document format that is readable by Windows and Mac systems using Adobe Reader, Acrobat, or
other programs. You can save multi-page documents in one PDF file. Recognized text in the scanned
document can be searched.

Note: If you do not see the Searchable PDF option, run the Epson Software Updater and install the
EPSON Scan OCR Component/Pro.

Parent topic: Scanning in Epson Scan 2

Scan Resolution Guidelines
The resolution setting in your scanning software, measured in dpi (dots per inch), controls the amount of
detail captured in your scans. Increasing the resolution raises the amount of detail captured but comes
with the following disadvantages:
• Larger file sizes
• It takes longer to scan your originals, send/receive your scans by email or fax, and to print your scans
• The image may become too large to fit on your display or print on paper
• The maximum length you can scan is reduced
If you plan to enlarge a scanned image so you can print it at a larger size, you may need to increase the
resolution from the default resolution set by the software. Follow these guidelines to determine the
resolution setting you need:
• You will scan the image at its original size but enlarge it later in an image-editing program.

Increase the resolution setting in your scanning software. Increase the resolution by the same amount
you will increase the image size to retain a high image quality. For example, if the resolution is 300 dpi
(dots per inch) and you will double the image size later, change the resolution setting to 600 dpi.

• You will scan the image at 100% or smaller size.
Select the resolution setting based on how you will use the scanned image:
• Email/view on a computer screen/post on the web: 96 to 200 dpi
• Print/fax/convert to editable text (OCR)/create searchable PDF: 200 to 300 dpi

• You will scan a long original.
Scan paper up to 240 inches (6096 mm) in length with a maximum resolution of 300 dpi or less.

Parent topic: Scanning
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Scanning Special Projects
Your product's scanning software offers various options to help you quickly complete special scan
projects.
Scanning Two Originals onto One Sheet (Stitching Images) - Windows
Scanning Multi-Page Originals as Separate Files - Windows
Saving Scanned Documents as a Searchable PDF Using Epson Scan 2
Saving Scanned Documents as a Searchable PDF with Document Capture - Mac
Saving a Scan as an Office Format File - Windows
Saving a Scan as an Office Format File - Mac
Scanning to a SharePoint Server or Cloud Service - Windows
Scanning to a SharePoint Server or Cloud Service - Mac
Parent topic: Scanning

Scanning Two Originals onto One Sheet (Stitching Images) - Windows
You can scan both sides of a double-sided or folded original in Document Capture Pro and combine
them into a single image with the Epson Scan 2 Stitch Images setting (not available for all products).

Note: Settings may vary depending on the software version you are using. Click the Help icon in
Document Capture Pro at any time for more information.

1. Load your original in the product.

Note: If an optional carrier sheet is included with your product, use it when scanning a folded original
or damage to the original may occur. Place the original into the carrier sheet with the folded edge
against the right side of the carrier sheet. Make sure to insert the carrier sheet into your product with
the white edge facing down.

2. Do one of the following to start Document Capture Pro:

• Windows 10: Click and select Epson Software > Document Capture Pro.
• Windows 8.x: Navigate to the Apps screen and select Document Capture Pro.

• Windows (other versions): Click or Start and select All Programs or Programs. Select
Epson Software > Document Capture Pro.

3. Select the Simple Scan tab.
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You see a window like this:

4. Click Scan Settings > Detailed Settings.
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You see an Epson Scan 2 window like this:
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5. Select Double-Sided as the Scanning Side setting.
6. Select the original document size or Auto Detect as the Document Size setting.
7. Select one of the following as the Stitch Images setting:

• Top & Bottom: Places the scanned images one above the other.
• Left & Right: Places the scanned images side by side.

8. Select the Advanced Settings tab and verify that the Edge Fill setting is set to None.
9. Click Save.
10. Click OK.
11. Click SCAN double-sided.

Your product scans the original and the image appears in the Edit Scanned Results window.

Note: If the scanned images are not stitched together in the correct orientation, click Scanning Side
on the Epson Scan 2 window, select Settings, set the Binding Edge to Left or Top, and rescan the
document.

12. Review and edit the scanned pages as necessary and click Next when you are finished.
13. Select a destination and any settings as necessary and click Complete.
Parent topic: Scanning Special Projects

Scanning Multi-Page Originals as Separate Files - Windows
You can use Document Capture Pro to scan multi-page originals as separate scanned files. You can
indicate how the separate files are created by defining a maximum page count per file or by inserting
blank pages, barcodes, or characters that can be detected by the software as separation markers.

Note: Settings may vary depending on the software version you are using. Click the Help icon in
Document Capture Pro at any time for more information.

1. Load your multi-page original in the product.
2. Do one of the following to start Document Capture Pro:

• Windows 10: Click and select Epson Software > Document Capture Pro.
• Windows 8.x: Navigate to the Apps screen and select Document Capture Pro.
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• Windows (other versions): Click or Start, and select All Programs or Programs. Select
Epson Software > Document Capture Pro.

You see the Document Capture Pro window.
3. Select the Job Scan tab.

You see a window like this:

4. Click the Job Settings button.
You see a window like this:
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5. Select New Job and select the scan settings. Click Next when finished.
You see a window like this:

6. Select the Apply job separation checkbox.
7. Select the method you want to use to separate the originals as the Separator setting. Click

Separation Settings to specify the settings for the selected option.
8. Finish creating the new scan job and click Save.
9. Click Back on the Job Settings screen.

Your originals are saved into separate files and folders as specified when the job is run.
Parent topic: Scanning Special Projects

Saving Scanned Documents as a Searchable PDF Using Epson Scan 2
You can scan a document and save the text in a searchable PDF. In a searchable PDF, text is
recognized using Optical Character Recognition (OCR) and then embedded in the scanned original.

Note: The required Epson Scan 2 OCR Component is installed automatically when you install your
product software. If you install your scanner software programs individually, be sure to also install this
component if you want to perform OCR.
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1. Load your original in the product for scanning.
2. Start Epson Scan 2.
3. Select your scan settings.
4. Click Preview and adjust the area you want to scan, if necessary.
5. Reload the ejected original in the scanner.
6. Select Searchable PDF as the Image Format setting.
7. Select Options from the Image Format list.

You see this window:

8. Select any of the options on the General tab.
9. Select the Text tab.
10. Make sure the language used in the document text is selected as the Text Language setting.
11. Select the Security tab if you want to add a password to the PDF or protect printing or editing

properties.
12. Click OK.
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13. Confirm the File Name setting and select a Folder setting for your document.
14. Click Scan.

The scanned image is saved as a searchable PDF.
Parent topic: Scanning Special Projects
Related topics
Loading Originals

Saving Scanned Documents as a Searchable PDF with Document Capture - Mac
You can scan a document with Document Capture and save the text in a searchable PDF. In a
searchable PDF, text is recognized using Optical Character Recognition (OCR) and then embedded in
the scanned original.

Note: The settings may vary, depending on the software version you are using. See the Help information
in Document Capture for details.

1. Load your original in the product for scanning.
2. Open the Applications folder, open the Epson Software folder, and select Document Capture.

You see a window like this:
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Note: You may need to select your scanner from the scanner list.

3. Click the Scan icon.
You see a window like this:

Note: If you want to use a scan job that you created instead, select it from the Job list in the
Document Capture window, click the Start Job button, and skip the rest of these steps.

4. Select any displayed scan settings you want to use.

Note: See the Help information in Document Capture for details.

5. If you want to select detailed scan settings, close the Scan Settings window, open the Scan menu at
the top of the Mac desktop, and select Displays the EPSON Scan Setup Screen.
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6. Click the Scan icon and select any detailed scan settings you want to use from the Epson Scan 2
window.

7. Click Scan.
You see a preview of your scan in the Document Capture window.

Note: You may have to close the Epson Scan 2 window to view your scan in the Document Capture
window.

8. If you would like to scan additional originals and add them to the current captured images, click the +
icon, select Acquire from Scanner, and repeat the previous steps.

9. Check the scanned images and edit them as necessary.
10. Open the File menu at the top of the Mac desktop and select Save As.
11. Select PDF as the File Type setting and click the Options button.
12. Select the Create Searchable PDF checkbox and click OK.
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13. Click one of the Destination icons to choose where to send your scanned file. (If you cannot see all
of the icons below, click the arrow next to the icons.)

14. Depending on the destination you chose, click OK or Send to complete the operation.
Parent topic: Scanning Special Projects
Related topics
Loading Originals

Saving a Scan as an Office Format File - Windows
You can use Document Capture Pro to save your scans in one of the following Microsoft Office file
formats: Microsoft Word (.docx), Microsoft Excel (.xlsx), or Microsoft PowerPoint (.pptx).

Note: The settings may vary, depending on the software version you are using. See the help information
in Document Capture Pro for details.

1. Load your original in the product.
2. Do one of the following to start Document Capture Pro:

• Windows 10: Click and select Epson Software > Document Capture Pro.
• Windows 8.x: Navigate to the Apps screen and select Document Capture Pro.

• Windows (other versions): Click or Start, and select All Programs or Programs. Select
Epson Software > Document Capture Pro.

3. Select the Simple Scan tab.



95

You see a window like this:

4. If you want to select specific scan settings for the scan, click the Scan Settings button, select any
displayed settings you want to use, and click OK.

Note: See the help information in Document Capture Pro for details.

5. Do one of the following:
• To scan the front side of an original, select SCAN single sided.
• To scan both sides of an original,select SCAN double sided.
Your product starts scanning and you see the Edit Scanned Results window.

6. View and edit the scanned pages as necessary and click Next when you are finished.

Note: See the help information in Document Capture Pro for details.

7. Click one of the destination icons (except Print) to choose where to send your scanned files. You
see the settings window.

8. Select the Office format file you want to use from the File Type drop-down list.

Note: The first time you select an Office format file you are prompted to download a plug-in update
for Microsoft Office files. Select Yes to download and install the plug-in.
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9. Click Option to display additional settings.
10. Select any additional settings as necessary and click OK.

Note: See the help information in Document Capture Pro for details.

11. Confirm your settings and click Complete.
Your originals are saved in the Office file format you selected.

Parent topic: Scanning Special Projects
Related topics
Loading Originals

Saving a Scan as an Office Format File - Mac
You can use Document Capture (Mac) to save your scans in one of these Microsoft Office file fomats:
Microsoft Word (.docx) and Microsoft Excel (.xlsx).

Note: The settings may vary, depending on the software version you are using. See the Help information
in Document Capture for details.

1. Load your original in the product for scanning.
2. Open the Applications folder, open the Epson Software folder, and select Document Capture.
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You see a window like this:

Note: You may need to select your scanner from the scanner list.

3. Click the Scan icon.
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You see a window like this:

Note: If you want to use a scan job that you created instead, select it from the Job list in the
Document Capture window, click the Start Job button, and skip the rest of these steps.

4. Select any displayed scan settings you want to use.

Note: See the Help information in Document Capture for details.

5. If you want to select detailed scan settings, close the Scan Settings window, open the Scan menu at
the top of the Mac desktop, and select Displays the EPSON Scan Setup Screen.

6. Click the Scan icon and select any detailed scan settings you want to use from the Epson Scan 2
window.

7. Click Scan.
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You see a preview of your scan in the Document Capture window.

Note: You may have to close the Epson Scan 2 window to view your scan in the Document Capture
window.

8. If you would like to scan additional originals and add them to the current captured images, click the +
icon, select Acquire from Scanner, and repeat the previous steps.

9. Check the scanned images and edit them as necessary.
10. Open the File menu at the top of the Mac desktop and select Save As.
11. Select DOCX (Word) or XLSX (Excel) as the File Type setting.

Note: The first time you select an Office file type setting in Document Capture, you see a prompt to
download a necessary plug-in for Microsoft Office files. Select Yes and follow the on-screen
instructions to download and install the plug-in to continue.

12. Click the Options button, select any necessary Office file type options, and click OK.
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13. Click one of the Destination icons to choose where to send your scanned file. (If you cannot see all
of the icons below, click the arrow next to the icons.)

14. Depending on the destination you chose, click OK or Send to complete the operation.
Parent topic: Scanning Special Projects
Related topics
Loading Originals

Scanning to a SharePoint Server or Cloud Service - Windows
You can use Document Capture Pro to upload scanned images to a SharePoint server or a cloud
service.

Note: The settings may vary, depending on the software version you are using. See the help information
in Document Capture Pro for details.

1. Load your original in the product.
2. Do one of the following to start Document Capture Pro:

• Windows 10: Click and select Epson Software > Document Capture Pro.
• Windows 8.x: Navigate to the Apps screen and select Document Capture Pro.

• Windows (other versions): Click or Start, and select All Programs or Programs. Select
Epson Software > Document Capture Pro.

3. Select the Simple Scan tab.
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You see a window like this:

4. If you want to select specific scan settings for the scan, click the Scan Settings button, select any
displayed settings you want to use, and click OK.

Note: See the help information in Document Capture Pro for details.

5. Do one of the following:
• To scan the front side of an original, select SCAN single sided.
• To scan both sides of an original,select SCAN double sided.
Your product starts scanning and you see the Edit Scanned Results window.

6. View and edit the scanned pages as necessary and click Complete when you are finished.

Note: See the help information in Document Capture Pro for details.

7. Click one of the cloud server or service destination icons. You see the settings window.
8. Enter any required information to set up the destination. You may need to log in to your cloud service

to authenticate the connection and allow Document Capture Pro to access the cloud service.
9. Adjust any settings and click Complete.

Note: See the help information in Document Capture Pro for details.
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Your originals are uploaded to the indicated server or cloud service.
Parent topic: Scanning Special Projects
Related topics
Loading Originals

Scanning to a SharePoint Server or Cloud Service - Mac
You can use Document Capture to upload scanned images to a SharePoint server or a cloud service.
1. Open the Applications folder, open the Epson Software folder, and select Document Capture.

You see a window like this:

Note: You may need to select your scanner from the scanner list.

2. Click the scan icon.
3. Select any displayed scan settings you want to use.

Note: See the Help information in Document Capture for details.

4. Click Scan.
You see a preview of your scan in the Document Capture window.



103

5. Click one of the cloud service Destination icons to choose where to save your scanned file. (If you
cannot see all of the icons, the service software may not be installed, the service may not be
available on your platform, or you need to click the arrow next to the icons.)
You see the Transfer Settings window.

6. Enter any required information to set up the destination. You may need to log in to your cloud service
to authenticate the connection and allow Document Capture to access the cloud service. If you have
previously created a saved setting for the destination, select it from the drop-down list.

7. Adjust any save settings, then click OK or Send, depending on the destination.
Your originals are scanned and uploaded to the indicated server or cloud service.

Parent topic: Scanning Special Projects
Related topics
Loading Originals
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Using the Optional Flatbed Scanner Dock - Windows
The optional flatbed scanner dock combines your document scanner with a flatbed scanner into a single
unit (DS-530 II/DS-770 II). This allows you to scan thick or over-sized originals, such as cardboard and
books, that won't fit into the document scanner's ADF.
You must purchase a flatbed scanner (Epson Perfection V19/V39) to use the optional flatbed scanner
dock. To attach the flatbed scanner and dock to your document scanner, follow the installation
instructions that came with your flatbed scanner dock.
See these sections to learn about the flatbed scanner dock option.

Note: Your product may differ from the images in this guide, but the instructions are the same unless
otherwise noted.

Flatbed Scanner Dock Parts
Scanning from the Flatbed Scanner Dock
Cleaning the Flatbed Scanner Dock
Transporting the Flatbed Scanner Dock

Flatbed Scanner Dock Parts
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1 Stopper
2 Output tray extension
3 Scanner cover/output tray

1 USB port 1 (for connecting flatbed dock to computer)
2 USB port 2 (for connecting flatbed dock to document scanner)
3 Power inlet

Parent topic: Using the Optional Flatbed Scanner Dock - Windows

Scanning from the Flatbed Scanner Dock
See these sections to scan when using the optional flatbed scanner dock.
Scanning from the Docked Flatbed Scanner
Scanning from the ADF with the Flatbed Scanner Dock Attached
Parent topic: Using the Optional Flatbed Scanner Dock - Windows

Scanning from the Docked Flatbed Scanner
You can place originals directly on the scanner glass of the flatbed scanner attached to the optional
flatbed scanner dock.
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Caution: Make sure the scanner is placed on a flat surface. Do not place heavy objects on the scanner
glass and do not press on the glass with too much force, or it may damage the scanner. Do not leave
photos on the scanner glass for an extended period, or they may stick to the glass.

1. Close the document scanner's output tray.

2. Open the flatbed scanner cover.

3. Place your original facedown on the scanner glass with the top edge facing as shown. Slide the
original to the edges of the indicated corner.
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Note: Place your original 0.1 inch (2.5 mm) from the top and side edges of the scanner glass as
shown in order to avoid cropping. If you are scanning multiple photos at once, place them at least
0.8 inch (20 mm) apart from each other.

4. Close the flatbed scanner cover gently to keep your original in place. If you are scanning a book or
other thick document, hold the scanner cover down as you scan.

5. Start Document Capture Pro (Windows), Document Capture (Mac), or Epson Scan 2.
6. Select Scanner Glass as the Document Source setting.
7. Select other scan settings as necessary.
8. Click Scan.
Parent topic: Scanning from the Flatbed Scanner Dock
Related tasks
Scanning from the ADF with the Flatbed Scanner Dock Attached
Scanning in Epson Scan 2

Scanning from the ADF with the Flatbed Scanner Dock Attached
Depending on the length of your originals, you may need to adjust the position of the input tray, output
tray, and stopper when scanning from the document scanner's ADF with the optional flatbed scanner
dock attached.
For originals shorter than 8.2 inches (210 mm) long:
• Open the document scanner's input tray, pull out the output tray and output tray extension, and open

the stopper.
• Extend the output tray a little longer than the length of the original and move the stopper forward or

backward as necessary.
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For originals between 8.2 inches (210 mm) and 11.7 inches (297 mm) long:
• Open and extend the document scanner's input tray, open the flatbed scanner's stopper, and slide the

stopper forward or backward so that it is a little longer than the length of the original. (Do not open the
output tray on the document scanner.)

For originals between 11.7 inches (297 mm) and 14 inches (356 mm) long:
• Open the document scanner's input tray, pull out and extend the scanner dock's output tray and output

tray extension, and open the stopper. (Do not open the output tray on the document scanner.)
• Extend the output tray a little longer than the length of the original and move the stopper forward or

backward as necessary.

For originals that are 14 inches (356 mm) or longer:
• Open the document scanner's input tray.
• Leave the output tray closed, and close the flatbed and document scanner's stoppers.
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Parent topic: Scanning from the Flatbed Scanner Dock
Related tasks
Scanning from the Docked Flatbed Scanner
Scanning in Epson Scan 2

Cleaning the Flatbed Scanner Dock
To keep your product working at its best, you should clean it several times a year.

Caution: Do not use a hard brush, alcohol, or paint thinner to clean the product or you may damage it.
Do not use oil or other lubricants inside the product or let water get inside it. Do not open the product
case.

1. Turn off the document scanner using the power button.

Note: There is no power button on the scanner dock.

2. Unplug the AC power cord and disconnect the USB cable that connects the flatbed scanner dock to
the computer.

3. Clean the outer case with a cloth dampened with mild detergent and water.
4. If the scanner glass is dirty, clean it with a soft dry cloth. If the glass surface is stained with grease or

some other hard-to-remove material, use a small amount of glass cleaner on a soft cloth to remove
it. Wipe off all remaining liquid.

Caution: Do not spray glass cleaner directly on the scanner glass. Do not press the surface of the
scanner glass with any force and be careful not to scratch or damage the scanner glass. A damaged
glass surface can decrease the scan quality.

Parent topic: Using the Optional Flatbed Scanner Dock - Windows

Transporting the Flatbed Scanner Dock
If you need to ship your product, transport it a long distance, or store it for an extended period, prepare it
for transportation as described here.

Note: If you are transporting only the flatbed scanner dock (without the document scanner), follow the
installation instructions that came with the flatbed scanner dock in reverse to remove the flatbed scanner
and dock from the document scanner.
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1. Turn off the document scanner using the power button.

Note: There is no power button on the flatbed scanner.

2. Unplug the AC power cord and disconnect the USB cable that connects the flatbed scanner dock to
the computer.
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3. Lift the entire scanner unit as shown, making sure to keep it level during transport.

4. Place the scanner unit in its original packing materials if possible, or use equivalent materials with
cushioning around the scanner.

Caution: Avoid turning the scanner upside down when transporting it or you may damage the
scanner.

Parent topic: Using the Optional Flatbed Scanner Dock - Windows
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Cleaning and Transporting Your Scanner
See these sections if you need to clean or transport your scanner.
Cleaning Your Scanner
Cleaning Inside Your Scanner
Replacing the Scanner Rollers
Transporting Your Scanner

Cleaning Your Scanner
To keep your product working at its best, you should clean it several times a year.

Caution: Do not use a hard brush, alcohol, or paint thinner to clean the product or you may damage it.
Do not use oil or other lubricants inside the product or let water get inside it. Do not open the product's
outer case.

1. Turn off the scanner and unplug the AC adapter.
2. Disconnect any connected cables.
3. Clean the outer case with a soft, dry cloth. Do not use liquid or chemical cleansers.

Note: If the outer case still requires additional cleaning, use a slightly damp cloth to wipe the outer
case. Then wipe the case with a soft, dry cloth.

Parent topic: Cleaning and Transporting Your Scanner

Cleaning Inside Your Scanner
Clean your scanner regularly to make sure that no dust builds up on the glass scanning surfaces. Dust
can cause spots or lines in your scanned images. Clean the inside of the scanner every 5,000 scans.
You can check the latest number of scans using the Epson Scan 2 Utility.

Note: The illustrations show the DS-575W II, but the instructions are the same for the DS-530 II and DS-
770 II.

Caution: Do not use a hard brush, alcohol, or paint thinner to clean the product or you may damage it.
Do not use oil or other lubricants inside the product or let water get inside it.
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1. Turn off the scanner and unplug the AC adapter.
2. Disconnect any connected cables.
3. Pull down on the cover open lever and open the scanner cover.

4. Use a genuine Epson cleaning kit or a soft, moist cloth to wipe off any dust or dirt on the glass
scanning surfaces and the rollers inside the scanner cover. If the glass surface is stained with
grease or some other hard-to-remove material, use a genuine Epson cleaning kit to remove stains.
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Use a small amount of cleaner on the cleaning cloth to remove the stains. Wipe off all remaining
liquid.

Caution: Do not spray glass cleaner directly on the scanning surfaces. Be careful not to place too
much force on the glass.

5. Use a cotton swab to wipe off any dust or dirt on the sensors.

Caution: Do not use liquid or glass cleaner on the cotton swab.



115

6. Wipe off any dust or dirt on the separation roller using a genuine Epson cleaning kit or a soft, moist
cloth.

Caution: Use only a genuine Epson cleaning kit or soft, moist cloth to clean the roller; using a dry
cloth may damage the surface of the roller.
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7. Wipe off any dust or dirt on the pickup roller using a genuine Epson cleaning kit or a soft, moist cloth.

Caution: Use only a genuine Epson cleaning kit or soft, moist cloth to clean the roller; using a dry
cloth may damage the surface of the roller.

8. Plug in the AC adapter and press the power button to turn on the scanner.
9. Hold down the start button for at least two seconds while opening the scanner cover. The rollers

on the bottom move momentarily, and then the scanner enters cleaning mode. Press the start
button several times to rotate the rollers shown here. Use a genuine Epson cleaning kit or a soft,
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moist cloth to wipe off any dust or dirt on the rollers as they rotate. Repeat this step until the rollers
are clean.

Caution: Be careful not to get your hands or hair caught in the mechanism when operating the roller.

10. Close the scanner cover.
Resetting the Number of Scans After Cleaning
Parent topic: Cleaning and Transporting Your Scanner

Resetting the Number of Scans After Cleaning
Reset the number of scans using the Epson Scan2 Utility after regular cleaning.
1. Make sure the scanner is turned on and connected to your computer.
2. Do one of the following to open the Epson Scan 2 Utility:

• Windows 10: Click and select EPSON > Epson Scan 2 Utility.
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• Windows 8.x: Navigate to the Apps screen and select EPSON > Epson Scan 2 Utility.

• Windows (other versions): Click or Start > All Programs or Programs > EPSON > Epson
Scan 2 > Epson Scan 2 Utility.

• Mac: Open the Applications folder, click Epson Software, and click Epson Scan 2 Utility.
3. Click the Maintenance tab.

You see a screen like this:

4. Select the Regular Cleaning Alert checkbox and click the Reset button.
5. Close the Epson Scan 2 Utility.
Parent topic: Cleaning Inside Your Scanner
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Replacing the Scanner Rollers
Replace the scanner rollers when the number of scans exceeds the life cycle of the rollers. Check the
scanner roller counter to see when you need to replace the rollers.

Note: The illustrations show the DS-575W II, but the instructions are the same for the DS-530 II and DS-
770 II.

Note: Frequent use of textured media may cause premature wear on the rollers. If frequent paper jams
occur before the life cycle of the rollers is exceeded, try cleaning the rollers. In some cases, the rollers
may need to be replaced before the number of scans exceeds the life cycle of the rollers.

1. Turn off the scanner.
2. Unplug the AC adapter.
3. Disconnect any connected cables.
4. Pull down on the cover open lever and open the scanner cover.
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5. Press down on the pickup roller cover latch and pull up the cover to remove it.
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6. Pull down the tab on the pickup roller and slide the roller to the right to remove it.

Note: Do not use force to pull out the pickup roller; doing so may damage the inside of the scanner.

7. To install the new pickup roller, align the notches on the roller unit and slide it to the left. Press up on
the tab to secure the roller.
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8. Align the bottom edge of the pickup roller cover into the notches as shown and press it down until it
clicks into place.

Note: If you are not able to close the cover, the pickup roller is not installed correctly. Remove the
roller unit and reinstall it, then try to close the cover again.
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9. Squeeze the tabs on the sides of the separation roller cover and open the cover.

Caution: Be careful not to apply too much force when opening the cover.

10. Slide the separation roller to the left and remove it.
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11. To install a new separation roller, insert the end of the roller into the hole on the right side and lower
the other end of the roller into place.

12. Close the separation roller cover until you hear it click into place.

Note: If you are not able to close the cover, the roller is not installed correctly. Remove the roller and
reinstall it, then try to close the cover again.

13. Close the scanner cover.
14. Connect any disconnected cables.
15. Plug in the AC adapter and turn on the scanner.
16. Reset the roller counter.

Note: Make sure to dispose of the pickup roller and the separation roller following the rules and
regulations of your local authority. Do not disassemble them.

Resetting the Scanner Roller Counter
Parent topic: Cleaning and Transporting Your Scanner
Related references
User Replaceable Epson Scanner Parts
Related tasks
Resetting the Number of Scans After Cleaning
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Resetting the Scanner Roller Counter

Resetting the Scanner Roller Counter
When you replace the scanner rollers, reset the scanner roller counter so you know when you may need
to replace the rollers again.
1. Make sure the scanner is turned on and connected to your computer.
2. Do one of the following to open the Epson Scan 2 Utility:

• Windows 10: Click and select EPSON > Epson Scan 2 Utility.
• Windows 8.x: Navigate to the Apps screen and select EPSON > Epson Scan 2 Utility.

• Windows (other versions): Click or Start > All Programs or Programs > EPSON > Epson
Scan 2 > Epson Scan 2 Utility.

• Mac: Open the Applications folder, click Epson Software, and click Epson Scan 2 Utility.
3. Click the Counter tab.
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You see a screen like this:

4. Click Reset.
The Number of Scans field changes to 0 (zero).

5. Close the Epson Scan 2 Utility.
Parent topic: Replacing the Scanner Rollers

Transporting Your Scanner
If you need to ship your product, transport it a long distance, or store it for an extended period, prepare it
for transportation as described here.



127

Note: The illustrations show the DS-575W II, but the instructions are the same for the DS-530 II and DS-
770 II.

1. Turn off the scanner and unplug the AC adapter.
2. Disconnect any connected cables.
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3. Close the input tray and the output tray.

Note: Make sure the output tray is securely closed.
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4. Place the scanner in its original packing materials, if possible, or use equivalent materials with
cushioning around the product.

Parent topic: Cleaning and Transporting Your Scanner
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Solving Problems
Check these sections for solutions to problems you may have using your product.

Note: Your product may differ from the images in this guide, but the instructions are the same unless
otherwise noted.

Scanner Light Status
Solving Scanning Problems
Solving Network Scanning Problems
Solving Scanned Image Quality Problems
Resetting the Epson Scan 2 Settings
Solving Flatbed Scanner Dock Problems
Uninstall Your Scanner Software
Where to Get Help (U.S. and Canada)
Where to Get Help (Latin America)

Scanner Light Status
You can often diagnose problems with your scanner by checking its lights.
DS-530 II/DS-770 II
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1 ! error light
2 automatic feeding mode light
3 ready light
4 double feed detection skip light
5 slow mode light

DS-575W II

1 AP mode light
2 Wi-Fi light
3 ! error light
4 automatic feeding mode light
5 ready light
6 double feed detection skip light
7 slow mode light
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Light status Condition/solution
The ! error light is flashing
slowly

A paper jam or a double feed has occurred. Remove any paper loaded
in the input tray. If the light continues to flash, a scanner error may have
occurred. Turn the scanner off and then back on again. If the error
continues, contact Epson for support.

The ! error light is on The scanner cover is open. Make sure the scanner cover is closed and
there is no jammed paper inside.

The following lights are
flashing quickly:
• ! error
• ready
• AP mode (DS-575W II)
• Wi-Fi (DS-575W II)

A fatal error has occurred. Try the following:
• Check the scanner connection to your computer to make sure it is

secure.
• Turn the scanner off and then back on again. If the error continues,

the scanner may be malfunctioning. Contact Epson for support.

The ready light is off and
the following lights are on:
• ! error
• automatic feeding mode
• double feed detection

skip
• slow mode
• AP mode (DS-575W II)
• Wi-Fi (DS-575W II)

The firmware update has failed and the scanner is in recovery mode.
Try updating the firmware again.

The Wi-Fi and ! error
lights are flashing slowly (DS-
575W II)

An access point settings error (security error) has occurred. Press the
stop button to clear the error, restart the devices you want to connect

to the network, then reconnect to the network.
The Wi-Fi light is flashing
slowly and ! error light is on
(DS-575W II)
The Wi-Fi (white) and
! error lights are flashing
slowly (DS-575W II)

A network connection error has occurred (the date and time have not
been set correctly). Reset the date and time in Web Config.
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Parent topic: Solving Problems
Related references
Original Jams in Scanner
Where to Get Help (U.S. and Canada)
Where to Get Help (Latin America)
Related topics
Loading Originals
Wi-Fi Networking
Scanning

Solving Scanning Problems
Check these solutions if you have problems scanning with your product.
Scanner Does Not Turn On or Turns Off Unexpectedly
Scanner Button Does Not Work as Expected
Scanning Software Does Not Operate Correctly
Cannot Start Epson Scan 2
Original Feeds Incorrectly in Scanner
Original Jams in Scanner
Paper Protection Does Not Work Correctly
Scanning is Slow
Parent topic: Solving Problems

Scanner Does Not Turn On or Turns Off Unexpectedly
If the scanner does not turn on or if it turns off unexpectedly, try these solutions:
• Make sure the AC adapter is securely connected to the scanner and to a working electrical outlet.
• If the scanner turns off unexpectedly, you may need to adjust the AC power or AC adapter setting in

the Epson Scan 2 Utility.
Parent topic: Solving Scanning Problems
Related tasks
Changing the Power Off and Sleep Timer Settings
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Scanner Button Does Not Work as Expected
If the scanner button does not start the correct program or perform the correct action, try these solutions:
• Document Capture Pro (Windows) and Document Capture (Mac) do not support using the start

button to scan over a wireless connection (DS-575W II). Connect the scanner using a USB cable or
launch Epson Scan 2 before scanning from the button on your scanner.

• Check that the correct scanner is selected using the Epson Scan 2 Utility.
• In Windows, be sure that the scanner is listed under Imaging Devices in the Device Manager.
• Make sure Document Capture Pro is installed correctly. If necessary, uninstall and reinstall it.
• Make sure you have assigned the correct job to the scanner button and change it, if necessary.
• Check the status of the lights and make sure the scanner is ready to scan.
• When using a wireless connection, start Epson Scan 2 on your computer before scanning from the

product (DS-575W II).
• Make sure Epson Scan 2 and other applications are installed correctly. If necessary, uninstall and

reinstall it.
Parent topic: Solving Scanning Problems
Related tasks
Adding and Assigning Scan Jobs with Document Capture Pro - Windows
Assigning Start Button Settings or Scan Jobs - Mac

Scanning Software Does Not Operate Correctly
If your scanning software does not operate correctly, try these solutions:
• Make sure your computer has adequate memory and meets the system requirements for your

operating system.
• Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so,

wake your system and restart your scanning software.
• Make sure the scanner is turned on.
• Make sure the connection between the scanner and your computer is secure.
• If you upgraded your operating system but did not reinstall your scanning software, try reinstalling it.
• In Windows, be sure that the scanner is listed under Imaging Devices in the Device Manager.
• Check that the correct scanner is selected using the Epson Scan 2 Utility.
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• Check that the correct setting is assigned to the scanner button in Document Capture Pro (Windows)
or Document Capture (Mac).

• Make sure the scanning software is installed.
• Use the USB cable that came with the scanner.
• Connect the scanner directly to the computer. The scanner may not work properly when connected

through a USB hub.
• If you are using a TWAIN-compliant program, make sure that the correct product is selected as the

Scanner or Source setting.
• Check that the Wi-Fi connection is working correctly. Try turning the wireless router off and on (DS-

575W II).
• If your scanner is connected to one computer via USB and another computer via wireless connection,

and Epson Scan 2 is running on the wirelessly connected computer, pressing the start button on the
scanner will save the scanned images to the wirelessly connected computer (DS-575W II).

Parent topic: Solving Scanning Problems
Related concepts
Uninstall Your Scanner Software
Related references
Windows System Requirements
Mac System Requirements

Cannot Start Epson Scan 2
If you cannot start Epson Scan 2, try these solutions:
• Make sure your scanner appears in the Epson Scan 2 Utility.
• Make sure your scanner is turned on and any interface cables are securely connected at both ends.
• Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so,

wake your system and restart Epson Scan 2.
• Connect the scanner directly to the computer. The scanner may not work properly when connected

through a USB hub.
• If you connected the scanner using a USB cable, make sure it is connected directly to your computer

or through only one USB hub.
• If you upgraded your operating system but did not reinstall Epson Scan 2, try reinstalling it.
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• If you are using a TWAIN-compliant program, make sure that the correct product is selected as the
Scanner or Source setting.

• Make sure the ready light stops flashing, indicating that the scanner is ready to scan.
Parent topic: Solving Scanning Problems
Related concepts
Uninstall Your Scanner Software
Related references
Windows System Requirements
Mac System Requirements

Original Feeds Incorrectly in Scanner
If you have problems feeding originals in your scanner, try these solutions:
• If multiple pages feed at once, try the following:

• Remove the originals, fan the edges to separate the sheets, if necessary, and reload them.
• Load fewer originals at a time.
• Load only originals that meet the specifications for your scanner.
• Clean inside the scanner and replace the roller assembly kit, if necessary.
• Check the pickup rollers and clean, if necessary.
• Scan the originals one by one using the Automatic Feeding Mode setting in Epson Scan 2.
• Press the slow mode button to slow down the scanning speed.
• Use Automatic Feeding Mode in Epson Scan 2 and scan originals one at a time.
• Use the optional carrier sheet for thin, folded, or irregularly shaped originals.

• If you see a double feed error in the Epson Scan 2 window or the Document Capture Pro window, start
Epson Scan 2, select the Main Settings tab, select the Detect Double Feed setting, and select Off.

Note: On a Mac, only Epson Scan 2 displays double feed errors. Document Capture for Mac does not
include this setting.

Parent topic: Solving Scanning Problems
Related tasks
Cleaning Inside Your Scanner
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Related topics
Loading Originals

Original Jams in Scanner
If an original has jammed inside the scanner, follow these steps:

Note: The illustrations show the DS-575W II, but the instructions are the same for the DS-530 II and DS-
770 II.

1. Turn off your scanner.
2. Remove all originals from the input tray.
3. Pull down the cover open lever and open the scanner cover.
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4. Gently pull out any jammed originals from inside the scanner.

5. Gently pull out any jammed originals from the output tray.
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6. Close the scanner cover.
7. Carefully follow all loading instructions when you reload originals.
If originals jam in the scanner frequently, try the following:
• Press the slow mode button to slow down the scanning speed.
• Turn off the Detect Double Feed setting.
• Clean inside the scanner and clean the rollers.
• Close the output tray and let the originals fall freely onto the surface below the scanner.
• If the roller counter is nearing end of life, replace the roller assembly kit.
Parent topic: Solving Scanning Problems
Related tasks
Cleaning Inside Your Scanner
Related topics
Loading Originals

Paper Protection Does Not Work Correctly
To reduce damage to the original, the Paper Protection feature stops immediately stops scanning if a
paper feed error is detected. If the Paper Protection feature does not work correctly, try these solutions:
• If your scanned original is damaged, make sure that the Paper Protection feature is enabled. Increase

the detection level, if necessary.
• If misdetection occurs frequently, lower the Paper Protection detection level in the Epson Scan 2 Utility

(On-Medium is the default).
• Turn the Paper Protection feature off in the Epson Scan 2 Utility (Scanner Setting > Paper

Protection > Off).

Note: Set the Paper Protection feature to Off when scanning plastic cards and thick originals.

• When scanning multiple originals, make sure that the leading edges of the documents are aligned. If
the leading edges of the documents are not aligned, they may be mistakenly detected as a paper feed
error even if they are scanned correctly.

• Make sure you align the edge guides with the original to avoid scanning at an angle.
Parent topic: Solving Scanning Problems
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Scanning is Slow
If scanning becomes slow, try these solutions:
• Scan your original at a lower resolution, if possible.
• Make sure your system meets the requirements for your operating system. If you are scanning a high-

resolution image, you may need more than the minimum requirements. If necessary, increase your
system's memory or reduce the resolution.

• Make sure you did not press the slow mode button to slow down the scanning speed.
• The scanning speed may be reduced depending on the image adjustment features in Epson Scan 2.
• If scanning becomes slower after scanning continuously with the ADF for a long time, the scanner may

have automatically slowed down to protect the scanner mechanism from overheating or becoming
damaged. Let the scanner rest with the power on for 30 minutes, then try scanning again.

• Make sure slow mode is turned off.
• If you are running virus protection or other security software, exclude the TWAIN.log files from

monitoring or set the TWAIN.log file as read only. See your virus protection or security software
instructions for details. The TWAIN.log file is saved in C:\Users\(user name)\AppData\Local\Temp.

Note: You may need to unhide system folders to view files in that location.

• If you are scanning over a wireless network, factors such as interference, network traffic, or weak
signal strength may affect your scanning speed (DS-575W II).

• Computers with USB 3.0 (SuperSpeed) or USB 2.0 (Hi-Speed) ports can scan faster than those with
USB 1.1 ports. If you are using a USB 3.0 or 2.0 port with the scanner, make sure it meets the system
requirements.

Parent topic: Solving Scanning Problems
Related references
Windows System Requirements
Mac System Requirements

Solving Network Scanning Problems
Check these solutions if you have problems scanning over a network (DS-575W II).
Cannot Scan Over a Network
Scanner Cannot Connect to a Wireless Router
Parent topic: Solving Problems
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Cannot Scan Over a Network
If you have problems scanning over a network, try these solutions:
• Move the scanner and computer or smart device closer to the access point.
• If you cannot scan from the start button on the scanner, make sure you restarted your computer

after installing the scanning software. Also start Epson Scan 2 before scanning with the start button.
• Document Capture Pro (Windows) and Document Capture (Mac) do not support starting a scan from

the scanner button over a wireless network. Launch Epson Scan 2 before scanning from the scanner
button over a network.

• If you are scanning a large original at a high resolution, a network communication error may occur. Try
scanning again at a lower resolution.

• If network communication was interrupted while starting Epson Scan 2, exit Epson Scan 2, wait a few
seconds, and restart it. If Epson Scan 2 cannot restart, turn off your scanner, turn it back on, and try
starting Epson Scan 2 again.

• Check the network connection setting in the Epson Scan 2 Utility.
• You may need to disable the firewall and any anti-virus software on your wireless router or access

point.
• If you see the message "Network product is not available: currently being used by user", there may be

a communication error between the scanner and computer. Restart the scanner.
• Epson Scan 2 does not support networks that use only IPv6. Use Epson Scan 2 on a network that

supports IPv4.
• If the Firewall function is active, the scanner may not be discovered by the Epson Scan 2 Utility. Open

the Epson Scan 2 Utility, enter the IP address for your scanner, and click Add.
• If the scanner and computer cannot communicate and are connected to the same network (subnet or

VLAN), check if your router uses the privacy separator and disable it, if necessary. Follow the
instructions in your router documentation to disable the privacy separator.

Parent topic: Solving Network Scanning Problems
Related topics
Wi-Fi Networking
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Scanner Cannot Connect to a Wireless Router
If your scanner has trouble finding or connecting to a wireless router, try these solutions:
• If you are connecting the scanner via Wi-Fi Protected Setup (WPS), make sure you activate WPS on

your scanner within 2 minutes of activating WPS discovery mode on the router by pressing the WPS
button or enabling the WPS setting in your router firmware.

• Make sure to place your scanner within contact range of your router. Avoid placing your scanner near
a microwave oven, 2.4 GHz cordless phone, or large metal object, such as a filing cabinet.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and
5 GHz) mode. If your router uses a single network name (SSID) for both the 2.4 GHz and 5 GHz band,
give each band its own network name (SSID) instead, such as Home Network 2.4 GHz and Home
Network 5 GHz. See your router documentation or contact your internet service provider for
instructions. Be sure to connect your scanner only to a 2.4 GHz network name (SSID).

• Verify that your router is operating correctly by connecting to it from your computer or another device.
• You may need to temporarily disable your firewall and any anti-virus software on your wireless router.

Then try scanning again. You can also unblock your scanner driver or network address in your firewall
or anti-virus software.

• Check to see if access restrictions, such as MAC address filtering, are set on the router. If access
restrictions are set, add your scanner's MAC address to your router's address list. To obtain your
scanner's MAC address, check the label on the back or bottom of your scanner. Then follow the
instructions in your router documentation to add the address to the list.

• If your router does not broadcast its network name (SSID), follow the instructions that came with your
scanner to enter your wireless network name manually.

• If your router has security enabled, determine the kind of security it is using and any required
password or passphrase for connection. Then make sure to enter the exact WEP key or WPA
passphrase correctly.

• Check if your computer is restricting the available wireless channels. If so, verify that your wireless
access point is using one of the usable channels and change to a usable channel, if necessary.

• The scanner may not be able to communicate with a computer with both Ethernet and Wi-Fi adapters
enabled. Disable all network interfaces except for the interface connected to the scanner.

• Enable the DHCP function on the access point or router.
• Check that the scanner's IP address is set correctly.
Parent topic: Solving Network Scanning Problems
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Related topics
Wi-Fi Networking

Solving Scanned Image Quality Problems
Check these sections if a scanned image on your computer screen has a quality problem.

Note: For solutions when using Document Capture Pro (Windows) or Document Capture (Mac)
software, see the Document Capture Pro (Windows) or Document Capture (Mac) help utility.

Back of Original Image Appears in Scanned Image
Scanned Characters are Blurry
Characters are not Recognized During Conversion to Editable Text (OCR)
Ripple Patterns Appear in an Image
Spots or Lines Appear in All Scanned Images
Scanned Image is Cropped
Parent topic: Solving Problems

Back of Original Image Appears in Scanned Image
If an image from the back of a thin original appears in your scanned image, make sure you selected the
correct Image Type setting for your original and select the Text Enhancement setting in Epson Scan 2.
You can also select the Remove Background setting in Epson Scan 2.

Note: If you select Color as the Image Type setting, you can change the level from Standard to High to
remove more of the background.

Parent topic: Solving Scanned Image Quality Problems
Related references
Image Format Options
Related tasks
Scanning in Epson Scan 2

Scanned Characters are Blurry
If characters in your scanned images are blurry, try these solutions:
• Make sure you do not move the scanner or original while scanning.
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• Operate the scanner on a flat, stable surface.
• Make sure the originals are ejecting properly.
• Adjust these Epson Scan 2 settings (if available) and try scanning again:

• Select the Text Enhancement setting.
• If the Image Type setting is Black & White, adjust the Threshold setting or change the Edge

Enhancement and Noise Reduction Level settings.
• Increase the Resolution setting.
• Set the Image Type to Grayscale.
• If you are scanning in JPEG format, change the compression level. Click Options in the Image

Format menu and change the Image Quality setting.
Parent topic: Solving Scanned Image Quality Problems
Related references
Image Format Options
Related tasks
Scanning in Epson Scan 2

Characters are not Recognized During Conversion to Editable Text (OCR)
If characters in your scanned images are not recognized during OCR conversion, try these solutions:
• Make sure your original is loaded straight on your product.
• Use an original with clear text.
• Adjust these Epson Scan 2 settings (if available) and try scanning again:

• Select the correct Image Type setting.
• Select or adjust the Text Enhancement setting.
• If the Image Type is set to Black & White, adjust the Threshold setting.
• Set the Image Type to Grayscale.

• Set the scanning resolution between 200 and 600 dpi.
• If the original document is in landscape mode, set the Rotate setting to Auto in Epson Scan 2.
• If you are using OCR software, check the manual for any additional adjustments.
• Scan thermal paper receipts as soon as possible. They may deteriorate due to age or friction.
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• When saving to Microsoft Office or Searchable PDF files, check that the correct languages are
selected. Check the language in each save setting window.

• Some font types may cause recognition errors. If the original font cannot be changed, you may need to
manually edit the unrecognized text.

Parent topic: Solving Scanned Image Quality Problems
Related references
Image Format Options
Related tasks
Scanning in Epson Scan 2

Ripple Patterns Appear in an Image
You may see a ripple pattern (called a moiré) in scanned images of printed documents. This is caused
by interference from differing pitches in the scanner's screen and your original's halftone screen. To
reduce this effect, adjust these Epson Scan 2 settings (if available) and try scanning again:
• Select the Descreening setting on the Advanced Settings tab.
• Select a lower Resolution setting.
Parent topic: Solving Scanned Image Quality Problems
Related references
Image Format Options
Related tasks
Scanning in Epson Scan 2

Spots or Lines Appear in All Scanned Images
If spots or lines appear in all your scanned images, try the following solutions:
• Clean the rollers and glass scanning surfaces inside your scanner using a genuine Epson cleaning kit

or a soft, moist cloth.
• Remove any dirt from your original.
• Enable the Detect Glass Dirt setting in the Epson Scan 2 Utility.

Note: If glass dirt detection does not work correctly, adjust the setting. If the glass dirt alert screen
appears after cleaning the inside of the scanner, check the glass surface again (scratches on the
glass may be detected as a glass dirt).
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Parent topic: Solving Scanned Image Quality Problems
Related tasks
Cleaning Inside Your Scanner

Scanned Image is Cropped
If the edges of a scanned image are cropped, try the following solutions:
• Select Auto Detect or Auto Detect (Long Paper) as the Document Size setting in Epson Scan 2,

Document Capture Pro, or Document Capture.
• If the document size is not detected correctly using the Auto Detect setting, select the size of your

original from the Document Size list.

Note: If the size you want to scan is not on the list, select Customize to create it manually (Windows
only).

• In Epson Scan 2, select the Main Settings tab. Select Document Size > Settings and adjust the
cropping area shown in the Crop Margins for Size "Auto" setting.

• In Epson Scan 2, select the Advanced Settings tab. Make sure the Edge Fill setting is set to None.
Parent topic: Solving Scanned Image Quality Problems
Related tasks
Scanning in Epson Scan 2
Scanning with Simple Scan in Document Capture Pro - Windows
Scanning with Job Scan in Document Capture Pro - Windows
Scanning with Document Capture - Mac

Resetting the Epson Scan 2 Settings
If you continue to experience image quality problems after trying all possible solutions, you may need to
reset the Epson Scan 2 settings using the Epson Scan 2 Utility.
1. Do one of the following to start the Epson Scan 2 Utility:

• Windows 10: Click > EPSON > Epson Scan 2 Utility.
• Windows 8.x: Navigate to the Apps screen and select Epson Scan 2 Utility.

• Windows (other versions): Click or Start, and select All Programs or Programs. Select
EPSON > Epson Scan 2 > Epson Scan 2 Utility.



147

• Mac: Open the Applications folder, open the Epson Software folder, and select Epson Scan 2
Utility.

2. Click the Other tab.
3. Click Reset and confirm your choice.

Note: If resetting the Epson Scan 2 settings does not solve your problem, uninstall Epson Scan 2 and re-
install it.

Parent topic: Solving Problems

Solving Flatbed Scanner Dock Problems
Check these solutions if you have problems scanning with the optional flatbed scanner dock (DS-530
II/DS-770 II).
Scanned Image Edges are Cropped
Line of Dots Appears in All Scanned Images
Back of Original Image Appears in Scanned Document
Parent topic: Solving Problems

Scanned Image Edges are Cropped
If the edges of a scanned image are cropped, make sure your original is placed correctly for scanning. If
necessary, move your original away from the edges of the scanner glass slightly.
In the Epson Scan 2 settings, set the Edge Fill setting to None.
Parent topic: Solving Flatbed Scanner Dock Problems

Line of Dots Appears in All Scanned Images
If a line of dots appears in all your scanned images, try these solutions:
• Clean the scanner glass with a soft, dry, lint-free cloth or use a small amount of glass cleaner on the

cloth, if necessary. Paper towels are not recommended.

Caution: Do not spray glass cleaner directly on the scanner glass.

• Make sure any interface cables are securely connected at both ends.
• Remove any dust or dirt that may have adhered to your original.
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• Do not press with too much force on the original or the document cover.
Keep the document cover closed to prevent dirt or dust from getting inside.
Parent topic: Solving Flatbed Scanner Dock Problems

Back of Original Image Appears in Scanned Document
If an image from the back of a thin original appears in your scanned image, try the following solutions:
• Place a piece of black paper on the back of the original and scan it again.
• Make sure you selected the correct Image Type setting for your original and select the Text

Enhancement setting in Epson Scan 2. You can also select the Remove Background setting in
Epson Scan 2.

• Adjust the Brightness setting in Epson Scan 2.
Parent topic: Solving Flatbed Scanner Dock Problems
Related references
Image Format Options
Related tasks
Scanning in Epson Scan 2

Uninstall Your Scanner Software
If you have a problem that requires you to uninstall and re-install your software, follow the instructions for
your operating system.
Uninstalling Scanner Software - Windows
Uninstalling Scanner Software - Mac
Parent topic: Solving Problems

Uninstalling Scanner Software - Windows
You can uninstall and then re-install your scanner software to solve certain problems.
1. Exit all applications currently running on your computer.
2. Turn off the scanner.
3. Disconnect any interface cables.
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4. Do the following to uninstall each of your scanning software programs and follow any on-screen
instructions:

• Windows 10: Click and select (Settings) > Apps > Apps & features. Select the scanner
software program and click Uninstall.

• Windows 8.x: Navigate to the Apps screen and select Control Panel > Programs > Programs
and Features. Select the scanner software program and click Uninstall/Change.

• Windows 7: Open the Windows Control Panel utility. Select Programs and Features. (In
Classic view, select Programs and click Uninstall a program.) Select the scanner software
program and click Uninstall/Change.

5. Restart your computer, then see the Start Here sheet to re-install your software.

Note: If you find that re-installing your scanner software does not solve a problem, contact Epson.

Parent topic: Uninstall Your Scanner Software

Uninstalling Scanner Software - Mac
In most cases, you do not need to uninstall your scanner software before re-installing it. However, you
can download the Uninstaller utility from the Epson support website to uninstall your scanner software as
described here.
1. To download the Uninstaller utility, visit epson.com/support (U.S.), epson.ca/support (Canada), or

latin.epson.com/support (Caribbean) and select your product.
2. Follow the instructions on the screen to install the Uninstaller utility.
3. Quit all applications currently running on your Mac.
4. Double-click the Uninstaller icon.
5. In the Epson Uninstaller screen, select the checkbox for each software program you want to

uninstall.
6. Click Uninstall.
7. Follow the on-screen instructions to uninstall the software.
8. To reinstall your scanner software, see the Start Here sheet for instructions.

Note: If you find that re-installing your scanner software does not solve a problem, contact Epson.

Parent topic: Uninstall Your Scanner Software

http://www.epson.com/support
http://www.epson.ca/support
https://latin.epson.com
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Where to Get Help (U.S. and Canada)
If you need to contact Epson for technical support services, use the following support options.

Internet Support
Visit Epson's support website at epson.com/support (U.S.) or epson.ca/support (Canada) and select
your product for solutions to common problems with your product. You can download utilities and
documentation, get FAQs and troubleshooting advice, or e-mail Epson with your questions.

Speak to a Support Representative
Before you call Epson for support, please have the following information ready:
• Product name
• Product serial number (located on a label on the product)
• Proof of purchase (such as a store receipt) and date of purchase
• Computer configuration
• Description of the problem
Then call:
• U.S.: (562) 276-4300, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM, Pacific

Time, Saturday
• Canada: (905) 709-3839, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM,

Pacific Time, Saturday
Days and hours of support are subject to change without notice. Toll or long distance charges may
apply.

Note: For help using any other software on your system, see the documentation for that software for
technical support.

Purchase Supplies and Accessories
You can purchase genuine Epson accessories at epson.com (U.S. sales) or epson.ca (Canadian sales).
You can also purchase accessories from an Epson authorized reseller. To find the nearest one, call 800-
GO-EPSON (800-463-7766) in the U.S. or 800-807-7766 in Canada.
Parent topic: Solving Problems

https://www.epson.com/support
https://www.epson.ca/support
https://www.epson.com
https://www.epson.ca
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Where to Get Help (Latin America)
If you need to contact Epson for technical support services, use the following support options.

Internet Support
Visit Epson's support website at latin.epson.com/support and select your product for solutions to
common problems. You can download utilities and documentation, get FAQs and troubleshooting
advice, or e-mail Epson with your questions.

Speak to a Support Representative
Before you call Epson for support, please have the following information ready:
• Product name
• Product serial number (located on a label on the product)
• Proof of purchase (such as a store receipt) and date of purchase
• Computer configuration
• Description of the problem
Then call:

Country Telephone
Argentina (54 11) 5167-0300

0800-288-37766
Bolivia* 800-100-116
Brazil State capitals and metropolitan areas: 3004-6627

Other areas: 0800-377-6627 / 0800-EPSONBR
Chile (56 2) 2484-3400
Colombia Bogota: (57 1) 592-2200

Other cities: 018000-915235
Costa Rica 800-377-6627
Ecuador* 1-800-000-044
El Salvador* 800-6570
Guatemala* 1-800-835-0358

https://latin.epson.com
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Country Telephone
Mexico Mexico City: (52 55) 1323-2052

Other cities: 01-800-087-1080
Nicaragua* 00-1-800-226-0368
Panama* 00-800-052-1376
Paraguay 009-800-521-0019
Peru Lima: (51 1) 418-0210

Other cities: 0800-10-126
Uruguay 00040-5210067
Venezuela (58 212) 240-1111

* Contact your local phone company to call this toll-free number from a mobile phone.
If your country does not appear in the list, contact the sales office in the nearest country. Toll or long
distance charges may apply.

Note: For help using any other software on your system, see the documentation for that software for
technical support.

Purchase Supplies and Accessories
You can purchase genuine Epson accessories from an Epson authorized reseller. To find the nearest
reseller, visit latin.epson.com or call your nearest Epson sales office.
Parent topic: Solving Problems

https://latin.epson.com
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Technical Specifications
These sections list the technical specifications for your scanner.

Note: Epson offers a recycling program for end of life Epson products. Please go to this site (U.S) or this
site (Canada) for information on how to return your Epson products for proper disposal.

Windows System Requirements
Mac System Requirements
General Specifications
Dimension Specifications
Electrical Specifications
Environmental Specifications
Flatbed Scanner Dock Specifications (DS-530 II/DS-770 II)
Network Interface Specifications (DS-575W II)
Safety and Approvals Specifications

Windows System Requirements
To use your product and its software, your computer should use one of these Microsoft operating
systems:
• Windows 10
• Windows 8.x
• Windows 7

Note: For the latest product software available for your operating system, visit the Epson support site at
epson.com/support (U.S.), epson.ca/support (Canada), or latin.epson.com/support (Caribbean), select
your product, and select Downloads.

Parent topic: Technical Specifications

Mac System Requirements
To use your product and its software, your Mac should use one of these operating systems:
• macOS 11.x

https://epson.com/recycle-program
https://www.epson.ca/recycle
https://www.epson.ca/recycle
http://www.epson.com/support
http://www.epson.ca/support
https://latin.epson.com/support
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• macOS 10.15.x
• macOS 10.14.x
• macOS 10.13.x
• macOS 10.12.x
• OS X 10.11.x
• OS X 10.10.x
• OS X 10.9.x
• OS X 10.8.x
• OS X 10.7.5

Note: The UNIX File System (UFS) for OS X and Fast User Switching on OS X is not supported.

For the latest product software available for your operating system, visit the Epson support site at
epson.com/support (U.S.), epson.ca/support (Canada), or latin.epson.com/support (Caribbean), select
your product, and select Downloads.
Parent topic: Technical Specifications

General Specifications
Scanner type Sheet feed, one pass duplex, color
Photoelectric device CIS
Effective pixels 5100 × 9300 pixels at 600 dpi

2550 × 64,500 pixels at 300 dpi
Document size Maximum: 8.5 × 240 inches (215.9 × 6096 mm)

Minimum: 2 × 2 inches (50.8 × 50.8 mm)
Paper input Facedown loading
Paper output Facedown ejection

http://www.epson.com/support
http://www.epson.ca/support
https://latin.epson.com/support
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Paper capacity DS-530 II/DS-575W II:
50 sheets of paper at 21 lb (80 g/m2) weight
DS-770 II:
100 sheets of paper at 21 lb (80 g/m2) weight

Scanning resolution 600 dpi (main scan)
600 dpi (sub scan)

Output resolution 50 to 1200 dpi in 1 dpi increments
53 inches (1346.0 mm) or less: up to 600 dpi
215 inches (5461.0 mm) or less: up to 300 dpi
240 inches (6096.0 mm) or less: up to 200 dpi

Color Depth Color:
30 bits per pixel internal (10 bits per pixel per color)
24 bits per pixel external (8 bits per pixel per color)
Grayscale:
10 bits per pixel internal
8 bits per pixel external
Black-and-white:
10 bits per pixel internal
1 bit per pixel external

Interface* SuperSpeed USB 3.0 (backward-compatible with USB 1.1)
IEEE802.11b/g/n (DS-575W II)

Light source RGB LED

* You cannot use a USB and network connection at the same time (DS-575W II).
Parent topic: Technical Specifications

Dimension Specifications
Height 6.9 inches (176 mm)
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Width 11.7 inches (296 mm)
Depth 6.7 inches (169 mm)
Weight 8.2 lb (3.7 kg)

Note: Dimensions do not include projecting parts.

Parent topic: Technical Specifications

Electrical Specifications
Scanner

Note: Check the label on the scanner and the AC adapter for voltage information. Power consumption
varies depending on operating conditions or whether an option is installed.

Rated DC input power supply
voltage

DC 24 V

Rated DC input current 1 A
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Power consumption DS-530 II/DS-770 II
Operating: 11 W (approximate) (DS-530 II)
12 W (approximate) (DS-770 II)
Ready mode: 5.4 W (approximate)
Sleep mode: 1.0 W (approximate)
Power off mode: 0.1 W (approximate)
DS-575W II
USB Connection:
Operating: 11 W (approximate)
Ready mode: 5.4 W (approximate)
Sleep mode: 1.0 W (approximate)
Power off mode: 0.1 W (approximate)
Wi-Fi Connection:
Operating: 12 W (approximate)
Ready mode: 5.5 W (approximate)
Sleep mode: 1.3 W (approximate)
Power off mode: 0.1 W (approximate)

AC Adapter

AC adapter model 100 to 240 V model: A461H
Rated input current 1 A
Rated frequency range 50 to 60 Hz
Rated output power supply
voltage

DC 24 V

Rated output current 1 A

Parent topic: Technical Specifications
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Environmental Specifications
Temperature Operating: 41 to 95 °F (5 to 35 °C)

Storage: –13 to 140 °F (–25 to 60 °C)
Humidity
(non-condensing)

Operating: 15 to 80% RH
Storage: 15 to 85% RH

Operating conditions Ordinary office or home conditions

Note: Avoid operating the scanner in direct sunlight, near a strong light source, or in extremely dusty
conditions.

Parent topic: Technical Specifications

Flatbed Scanner Dock Specifications (DS-530 II/DS-770 II)
Interface Hi-Speed USB
Rated DC input power supply
voltage

DC 24 V

Dimensions
(when assembled with a sheet
feed scanner and a flatbed
scanner)

Width: 11.8 inches (300 mm)
Depth: 18.9 inches (481 mm)
Height 9.6 inches (245 mm)

Weight Approximately 2.4 lb (1.1 kg)
Temperature Operating: 50 to 95 °F (10 to 35 °C)

Storage: –4 to 140 °F (–20 to 60 °C)
Humidity
(non-condensing)

Operating: 20 to 80%
Storage: 20 to 85%

Parent topic: Technical Specifications
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Network Interface Specifications (DS-575W II)
Wi-Fi

Wireless LAN standard IEEE802.11 b/g/n
Wireless security WPA2-PSK (AES); WPA2 compliant support for WPA/WPA2

Personal
WPA2-Enterprise; WPA2 compliant with support for WPA/WPA2
Enterprise
WEP (64/128 bit)

Frequency range 2.4 GHz
Communication mode Infrastructure mode

Ad hoc mode; not supported for IEEE802.11n
AP mode; not supported for IEEE802.11b

Radio frequency power
transmitted

Maximum 20 dBm (EIRP)

Note: AP mode and Wi-Fi connection can be used at the same time.
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Security Protocol

SSL/TLS HTTPS (Server/Client)
SMTPS (Client)
STARTTLS
Root certificate (Client)
Root certificate updating (Client)
CA-signed certificate (Server)
CA certificate (Server)
CSR generation (Server)
Self-signed certificate (Server)
EC key CSR/self-signed certificate generation (Server)
Certificates/Secret key imports (Server)

Authentication for email sending POP before SMTP, APOP, SMTP Authentication
MIB accessing
Authentication/Encryption

SNMPv3

Parent topic: Technical Specifications

Safety and Approvals Specifications
Scanner

United States EMC: FCC part 15 Subpart B class B
Canada EMC: CAN ICES-3 (B)/NMB-3 (B)

AC Adapter (A461H)

United States Safety: UL60950-1
EMC: FCC part 15 Subpart B class B

Canada Safety: CAN/CSA C22.2 No. 60950-1
EMC: CAN ICES-3 (B)/NMB-3 (B)
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Optional Flatbed Scanner Dock (DS-530 II/DS-770 II)

United States EMC: FCC part 15 Subpart B class B
Canada EMC: CAN/CSA-CEI/IEC CISPR 22 class B

This equipment contains the following wireless module: (DS-575W II)
• Manufacturer: FOXCONN ELECTRONICS INC.
• Type: J26H006
This product conforms to Part 15 of the FCC Rules and RSS-210 of the IC Rules. Epson cannot accept
responsibility for any failure to satisfy the protection requirements resulting from a non-recommended
modification of the product. Operation is subject to the following two conditions: (1) this device may not
cause harmful interference, and (2) this device must accept any interference received, including
interference that may cause undesired operation of the device.
To prevent radio interference to the licensed service, this device is intended to be operated indoors and
away from windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed
outdoors is subject to licensing.
This equipment complies with FCC/IC radiation exposure limits set forth for an uncontrolled environment
and meets the FCC radio frequency (RF) Exposure Guidelines in Supplement C to OET65 and RSS-102
of the IC radio frequency (RF) Exposure rules. This equipment should be installed and operated so that
the radiator is kept at least 7.9 inches (20 cm) or more away from a person's body (excluding extremities:
hands, wrists, feet and ankles).

Notice for Argentina

CNC ID: C-20841

Notice for Mexico
Operation is subject to the following two conditions: (1) this device may not cause harmful interference,
and (2) this device must accept any interference received, including interference that may cause
undesired operation of the device.
Product model: J382E (DS-575W II)
Brand: EPSON
IFT Certification Number: RCPEPJ218-0025
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Notice for Paraguay
Imported by:
Fastrax, S.A.
Av. Perú esq. Río de Janeiro, Barrio Las Mercedes, Asunción, Paraguay
Imported by:
Sol Control S.R.L.
Av. Gral. Bernardino Caballero 810 esq. Celsa Speratti, Asunción, Paraguay

Notice for Peru
Product Model: DS-575W II (J382E)
Brand: EPSON
This product uses the following WLAN module:
WLAN Module Model: J26H006
FCC ID: BKMFBJ26H006
Product Manufacturer: Seiko Epson Corporation
Address: 3-3-5 Owa Suwa-shi, Nagano-Ken 392-8502, Japan
Parent topic: Technical Specifications



163

Notices
Check these sections for important notices about your scanner.

Note: Epson offers a recycling program for end of life Epson products. Please go to this site (U.S) or this
site (Canada) for information on how to return your Epson products for proper disposal.

Important Safety Instructions
Restrictions on Copying
Default Delay Times for Power Management for Epson Products
Binding Arbitration and Class Waiver
Trademarks
Copyright Notice

Important Safety Instructions
Follow these safety instructions when setting up and using the scanner:
• Read all these instructions, and follow all warnings and instructions marked on the scanner.
• Place the scanner close enough to the computer for the interface cable to reach it easily.
• Do not use with wet hands.
• When connecting this product to a computer or other device with a cable, ensure the correct

orientation of the connectors. Each connector has only one correct orientation. Inserting a connector
in the wrong orientation may damage both devices connected by the cable.

• Do not insert objects into any opening as they may touch dangerous voltage points or short out parts.
Beware of electrical shock hazards.

• Place the product on a flat, stable surface that extends beyond the base of the product in all directions.
If you place the product by the wall, leave at least 3.9 inches (10 cm) between the back of the product
and the wall.

• After replacing consumable parts, dispose of them correctly following the rules of your local authority.
Do not disassemble them.

• Do not place or store the scanner outdoors, in a car, near excessive dirt or dust, water, heat sources,
or in locations subject to shocks, vibrations, condensation, high temperature or humidity, direct
sunlight, strong light sources, or rapid changes in temperature or humidity.

https://epson.com/recycle-program
https://www.epson.ca/recycle
https://www.epson.ca/recycle
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• Never disassemble, modify, or attempt to repair the scanner or a scanner option by yourself except as
specifically explained in this guide.

Caution: Radio waves from this product may adversely affect the operation of medical equipment,
airplanes, or automatically controlled devices, such as pacemakers, automatic doors, or fire alarms.
When using this product near such devices or inside a medical facility, follow the directions from
authorized staff members at the facility, and follow all posted warnings and directions on the device to
avoid causing an accident (DS-575W II).

AC Adapter
• Do not place or store the AC adapter outdoors, in a car, near excessive dirt or dust, water, heat

sources, or in locations subject to shocks, vibrations, condensation, high temperature or humidity,
direct sunlight, strong light sources, or rapid changes in temperature or humidity.

• Place the scanner and the AC adapter near an electrical outlet where the adapter can be easily
unplugged.

• The AC power cord should be placed to avoid abrasions, cuts, fraying, crimping, and kinking.
• Do not place objects on top of the AC power cord and do not allow the AC adapter or the power cord

to be stepped on or run over. Be particularly careful to keep the AC power cord straight at the end and
the point where it enters the AC adapter.

• Use only the AC adapter that comes with your scanner. Using any other adapter could cause fire,
electrical shock, or injury.

• Use only the power cord that comes with your scanner. Use of another cord may cause fires or shock.
Do not use the cord with any other equipment.

• The AC adapter is designed for use with the scanner with which it was included. Do not attempt to use
it with other electronic devices unless specified.

• Use only the type of power source indicated on the AC adapter's label, and always supply power
directly from a standard domestic electrical outlet with the AC adapter that meets the relevant local
safety standards.

• Avoid using outlets on the same circuit as photocopiers or air control systems that regularly switch on
and off.

• If you use an extension cord with the scanner, make sure the total ampere rating of the devices
plugged into the extension cord does not exceed the cord's ampere rating. Also, make sure the total
ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet's ampere
rating.
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• Never disassemble, modify, or attempt to repair the AC adapter by yourself except as specifically
explained in the scanner's guides.

• If damage occurs to the plug, replace the cord set or consult a qualified electrician. If there are fuses in
the plug, make sure you replace them with fuses of the correct size and rating.

• Unplug the scanner and the AC adapter, and refer servicing to qualified service personnel under the
following conditions: The AC adapter or plug is damaged; liquid has entered the scanner or the AC
adapter; the scanner or the AC adapter has been dropped or the case has been damaged; the
scanner or the AC adapter does not operate normally or exhibits a distinct change in performance. (Do
not adjust controls that are not covered by the operating instructions.)

• Unplug the scanner and the AC adapter before cleaning. Clean with a damp cloth only. Do not use
liquid or aerosol cleaners.

• If you are not going to use the scanner for a long period, be sure to unplug the AC adapter from the
electrical outlet.

USB
• Use only the USB cable supplied with your product. Using any other USB cable could cause fire,

electrical shock, or injury.
• The USB cable is designed for use with the product with which it was included. Do not attempt to use it

with other electrical devices unless specified.
• The USB cable should be placed to avoid abrasions, cuts, fraying, crimping, and kinking.
• Do not place objects on top of the USB cable and do not allow the cable to be stepped on or run over.

Be particularly careful to keep the USB cable straight at the end.
• If you are not going to use the product for a long period, unplug the USB cable from the computer.
• Unplug the scanner and the USB cable, and refer servicing to qualified service personnel under the

following conditions: Liquid has entered the scanner; the scanner has been dropped or the case has
been damaged; the scanner does not operate normally or exhibits a distinct change in performance.
(Do not adjust controls that are not covered by the operating instructions.)

Parent topic: Notices

Restrictions on Copying
Observe the following restrictions to ensure responsible and legal use of your scanner.
Copying of the following items is prohibited by law:
• Bank bills, coins, government-issued marketable securities, government bond securities, and

municipal securities
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• Unused postage stamps, pre-stamped postcards, and other official postal items bearing valid postage
• Government-issued revenue stamps, and securities issued according to legal procedure
Exercise caution when copying the following items:
• Private marketable securities (stock certificates, negotiable notes, checks, etc.), monthly passes,

concession tickets, etc.
• Passports, driver's licenses, warrants of fitness, road passes, food stamps, tickets, etc.

Note: Copying these items may also be prohibited by law.

Restriction on disassembling and decompiling
You may not disassemble, decompile, or otherwise attempt to derive the source code of any software
included with this product.
Parent topic: Notices

Default Delay Times for Power Management for Epson Products
This product will enter sleep mode after a period of nonuse. This is to ensure that the product meets
Energy Star standards of energy efficiency. More energy savings can be achieved by setting the time to
sleep to a shorter interval.
Parent topic: Notices

Binding Arbitration and Class Waiver
1. DISPUTES, BINDING INDIVIDUAL ARBITRATION, AND WAIVER OF CLASS ACTIONS AND
CLASS ARBITRATIONS
1.1 Disputes. The terms of this Section 1 shall apply to all Disputes between you and Epson. The term
"Dispute" is meant to have the broadest meaning permissible under law and includes any dispute, claim,
controversy or action between you and Epson arising out of or relating to this Agreement, Epson
branded products (hardware and including any related software), or other transaction involving you and
Epson, whether in contract, warranty, misrepresentation, fraud, tort, intentional tort, statute, regulation,
ordinance, or any other legal or equitable basis. "DISPUTE" DOES NOT INCLUDE IP CLAIMS, or more
specifically, a claim or cause of action for (a) trademark infringement or dilution, (b) patent infringement,
(c) copyright infringement or misuse, or (d) trade secret misappropriation (an "IP Claim"). You and Epson
also agree, notwithstanding Section 1.6,that a court, not an arbitrator, may decide if a claim or cause of
action is for an IP Claim.
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1.2 Binding Arbitration. You and Epson agree that all Disputes shall be resolved by binding arbitration
according to this Agreement. ARBITRATION MEANS THAT YOU WAIVE YOUR RIGHT TO A JUDGE
OR JURY IN A COURT PROCEEDING AND YOUR GROUNDS FOR APPEAL ARE LIMITED.
Pursuant to this Agreement, binding arbitration shall be administered by JAMS, a nationally recognized
arbitration authority, pursuant to its code of procedures then in effect for consumer related disputes, but
excluding any rules that permit joinder or class actions in arbitration (for more detail on procedure, see
Section 1.6 below). You and Epson understand and agree that (a) the Federal Arbitration Act (9 U.S.C.
§1, et seq.) governs the interpretation and enforcement of this Section 1, (b) this Agreement
memorializes a transaction in interstate commerce, and (c) this Section 1 shall survive termination of this
Agreement.
1.3 Pre-Arbitration Steps and Notice. Before submitting a claim for arbitration, you and Epson agree to
try, for sixty (60) days, to resolve any Dispute informally. If Epson and you do not reach an agreement to
resolve the Dispute within the sixty (60) days), you or Epson may commence an arbitration. Notice to
Epson must be addressed to: Epson America, Inc., ATTN: Legal Department, 3840 Kilroy Airport Way,
Long Beach, CA 90806 (the "Epson Address"). The Dispute Notice to you will be sent to the most recent
address Epson has in its records for you. For this reason, it is important to notify us if your address
changes by emailing us at EAILegal@ea.epson.com or writing us at the Epson Address above. Notice of
the Dispute shall include the sender's name, address and contact information, the facts giving rise to the
Dispute, and the relief requested (the "Dispute Notice"). Following receipt of the Dispute Notice, Epson
and you agree to act in good faith to resolve the Dispute before commencing arbitration.
1.4 Small Claims Court. Notwithstanding the foregoing, you may bring an individual action in the small
claims court of your state or municipality if the action is within that court's jurisdiction and is pending only
in that court.
1.5 WAIVER OF CLASS ACTIONS AND CLASS ARBITRATIONS. YOU AND EPSON AGREE THAT
EACH PARTY MAY BRING DISPUTES AGAINST THE OTHER PARTY ONLY IN AN INDIVIDUAL
CAPACITY, AND NOT AS A PLAINTIFF OR CLASS MEMBER IN ANY CLASS OR
REPRESENTATIVE PROCEEDING, INCLUDING WITHOUT LIMITATION FEDERAL OR STATE
CLASS ACTIONS, OR CLASS ARBITRATIONS. CLASS ACTION LAWSUITS, CLASS-WIDE
ARBITRATIONS, PRIVATE ATTORNEY-GENERAL ACTIONS, AND ANY OTHER PROCEEDING
WHERE SOMEONE ACTS IN A REPRESENTATIVE CAPACITY ARE NOT ALLOWED.
ACCORDINGLY, UNDER THE ARBITRATION PROCEDURES OUTLINED IN THIS SECTION, AN
ARBITRATOR SHALL NOT COMBINE OR CONSOLIDATE MORE THAN ONE PARTY'S CLAIMS
WITHOUT THE WRITTEN CONSENT OF ALL AFFECTED PARTIES TO AN ARBITRATION
PROCEEDING.
1.6 Arbitration Procedure. If you or Epson commences arbitration, the arbitration shall be governed by
the rules of JAMS that are in effect when the arbitration is filed, excluding any rules that permit arbitration
on a class or representative basis (the "JAMS Rules"), available at http://www.jamsadr.com or by calling
1-800-352-5267, and under the rules set forth in this Agreement. All Disputes shall be resolved by a
single neutral arbitrator, and both parties shall have a reasonable opportunity to participate in the

http://www.jamsadr.com
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selection of the arbitrator. The arbitrator is bound by the terms of this Agreement. The arbitrator, and not
any federal, state or local court or agency, shall have exclusive authority to resolve all disputes arising
out of or relating to the interpretation, applicability, enforceability or formation of this Agreement,
including any claim that all or any part of this Agreement is void or voidable. Notwithstanding this broad
delegation of authority to the arbitrator, a court may determine the limited question of whether a claim or
cause of action is for an IP Claim, which is excluded from the definition of "Disputes" in Section 1.1
above. The arbitrator shall be empowered to grant whatever relief would be available in a court under
law or in equity. The arbitrator may award you the same damages as a court could, and may award
declaratory or injunctive relief only in favor of the individual party seeking relief and only to the extent
necessary to provide relief warranted by that party's individual claim. In some instances, the costs of
arbitration can exceed the costs of litigation and the right to discovery may be more limited in arbitration
than in court. The arbitrator's award is binding and may be entered as a judgment in any court of
competent jurisdiction.
You may choose to engage in arbitration hearings by telephone. Arbitration hearings not conducted by
telephone shall take place in a location reasonably accessible from your primary residence, or in Orange
County, California, at your option.
a) Initiation of Arbitration Proceeding. If either you or Epson decides to arbitrate a Dispute, both parties
agree to the following procedure:
(i) Write a Demand for Arbitration. The demand must include a description of the Dispute and the amount
of damages sought to be recovered. You can find a copy of a Demand for Arbitration at
http://www.jamsadr.com ("Demand for Arbitration").
(ii) Send three copies of the Demand for Arbitration, plus the appropriate filing fee, to: JAMS, 500 North
State College Blvd., Suite 600 Orange, CA 92868, U.S.A.
(iii) Send one copy of the Demand for Arbitration to the other party (same address as the Dispute
Notice), or as otherwise agreed by the parties.
b) Hearing Format. During the arbitration, the amount of any settlement offer made shall not be disclosed
to the arbitrator until after the arbitrator determines the amount, if any, to which you or Epson is entitled.
The discovery or exchange of non-privileged information relevant to the Dispute may be allowed during
the arbitration.
c) Arbitration Fees. Epson shall pay, or (if applicable) reimburse you for, all JAMS filings and arbitrator
fees for any arbitration commenced (by you or Epson) pursuant to provisions of this Agreement.
d) Award in Your Favor. For Disputes in which you or Epson seeks $75,000 or less in damages exclusive
of attorney's fees and costs, if the arbitrator's decision results in an award to you in an amount greater
than Epson's last written offer, if any, to settle the Dispute, Epson will: (i) pay you $1,000 or the amount
of the award, whichever is greater; (ii) pay you twice the amount of your reasonable attorney's fees, if
any; and (iii) reimburse you for any expenses (including expert witness fees and costs) that your attorney
reasonably accrues for investigating, preparing, and pursuing the Dispute in arbitration. Except as

http://www.jamsadr.com
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agreed upon by you and Epson in writing, the arbitrator shall determine the amount of fees, costs, and
expenses to be paid by Epson pursuant to this Section 1.6d).
e) Attorney's Fees. Epson will not seek its attorney's fees and expenses for any arbitration commenced
involving a Dispute under this Agreement. Your right to attorney's fees and expenses under Section
1.6d) above does not limit your rights to attorney's fees and expenses under applicable law;
notwithstanding the foregoing, the arbitrator may not award duplicative awards of attorney's fees and
expenses.
1.7 Opt-out. You may elect to opt-out (exclude yourself) from the final, binding, individual
arbitration procedure and waiver of class and representative proceedings specified in this
Agreement by sending a written letter to the Epson Address within thirty (30) days of your assent
to this Agreement (including without limitation the purchase, download, installation of the
Software or other applicable use of Epson Hardware, products and services) that specifies (i)
your name, (ii) your mailing address, and (iii) your request to be excluded from the final, binding
individual arbitration procedure and waiver of class and representative proceedings specified in
this Section 1. In the event that you opt-out consistent with the procedure set forth above, all
other terms shall continue to apply, including the requirement to provide notice prior to litigation.
1.8 Amendments to Section 1. Notwithstanding any provision in this Agreement to the contrary, you
and Epson agree that if Epson makes any future amendments to the dispute resolution procedure and
class action waiver provisions (other than a change to Epson's address) in this Agreement, Epson will
obtain your affirmative assent to the applicable amendment. If you do not affirmatively assent to the
applicable amendment, you are agreeing that you will arbitrate any Dispute between the parties in
accordance with the language of this Section 1 (or resolve disputes as provided for in Section 1.7, if you
timely elected to opt-out when you first assented to this Agreement).
1.9 Severability. If any provision in this Section 1 is found to be unenforceable, that provision shall be
severed with the remainder of this Agreement remaining in full force and effect. The foregoing shall not
apply to the prohibition against class or representative actions as provided in Section 1.5. This
means that if Section 1.5 is found to be unenforceable, the entire Section 1 (but only Section 1)
shall be null and void.
Parent topic: Notices

Trademarks
EPSON®, Epson Smart Panel®, and Perfection® are registered trademarks and EPSON Exceed Your
Vision is a registered logomark of Seiko Epson Corporation.
Windows is a registered trademark of Microsoft Corporation in the United States and/or other countries.
Apple, App Store, macOS, and OS X are trademarks of Apple Inc., registered in the U.S. and other
countries.
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Google® is a registered trademark and AndroidTM and Google PlayTM are trademarks of Google LLC.
General Notice: Other product names used herein are for identification purposes only and may be
trademarks of their respective owners. Epson disclaims any and all rights in those marks.

Parent topic: Notices

Copyright Notice
All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or
transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise,
without the prior written permission of Seiko Epson Corporation. The information contained herein is
designed only for use with this Epson product. Epson is not responsible for any use of this information as
applied to other products.
Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third
parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of:
accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this
product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's operating and
maintenance instructions.
Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any
options or any consumable products other than those designated as Original Epson Products or Epson
Approved Products by Seiko Epson Corporation.
Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic
interference that occurs from the use of any interface cables other than those designated as Epson
approved Products by Seiko Epson Corporation.
This information is subject to change without notice.
libTIFF Software Acknowledgment
A Note Concerning Responsible Use of Copyrighted Materials
Copyright Attribution
Parent topic: Notices
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libTIFF Software Acknowledgment
Copyright © 1988-1997 Sam Leffler
Copyright © 1991-1997 Silicon Graphics, Inc.
Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose
is hereby granted without fee, provided that (I) the above copyright notices and this permission notice
appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and
Silicon Graphics may not be used in any advertising or publicity relating to the software without the
specific, prior written permission of Sam Leffler and Silicon Graphics.
THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS,
IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL,
INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT
ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT
OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.
Parent topic: Copyright Notice

A Note Concerning Responsible Use of Copyrighted Materials
Epson encourages each user to be responsible and respectful of the copyright laws when using any
Epson product. While some countries' laws permit limited copying or reuse of copyrighted material in
certain circumstances, those circumstances may not be as broad as some people assume. Contact your
legal advisor for any questions regarding copyright law.
Parent topic: Copyright Notice

Copyright Attribution
© 2020 Epson America, Inc.
11/20
CPD-59609
Parent topic: Copyright Notice
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